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1.  PURPOSE.  This handbook provides guidance and prescribes technical standards, tolerances, 
and procedures applicable to the maintenance and inspection of the Digital Voice Recorder System 
(DVRS).  This information augments information available in instruction books and other 
handbooks and complements the latest edition of Order 6000.15, General Maintenance Handbook 
for National Airspace System (NAS) Facilities. 

2.  DISTRIBUTION.  This document requires actions by the Airway Transportation System 
Specialist (ATSS) at operational facilities with Facility, Service, and Equipment Profile (FSEP) 
equipment:  DVRS. 

a. The ATSS and all administrative personnel must subscribe to the Auto-Notifications 
Services for electronic library release notifications at http://technet.faa.gov/.  Administrative 
offices can print these documents for local use as required. 

b. For electronic copies, use the Technical Library website at http://nas.amc.faa.gov. 

c. The ATSS must keep accurate FSEP records and Logistics Inventory System (LIS) 
addresses to receive printed copies.  Printed copies are mailed to the ATSS at operational 
facilities with an accurate FSEP record using the LIS mailing address per Orders 6000.5D, 
Facility, Service, and Equipment Profile (FSEP) and Order 1720.30C, Distribution of Airway 
Facilities Technical Directives. 

d. To update LIS, contact the LIS point of contact for your service area.  To update FSEP 
information, visit this link:  
https://intranet.faa.gov/faaemployees/org/linebusiness/ato/operations/technical_operations/ajw16
2/fsep/contacts/. 

3.  CANCELLATIONS.  Order JO 6670.13, Maintenance of Digital Voice Recorder (DVR) 
Equipment, dated December 6, 1999, is cancelled. 

4.  EXPLANATION OF CHANGES.  Extensive revisions to this order have been made to 
incorporate changes resulting from field, regional, and headquarter comments.  These changes 
include the revisions of Chapter 3, Standards and Tolerances, Chapter 4, Periodic Maintenance, 
and Chapter 5, Maintenance Procedures. 
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5.  MAINTENANCE AND MODIFICATION PROCEDURE. 

 a. Order 6000.15, this handbook, the applicable equipment instruction book, and other 
applicable directives shall be consulted and used together by the system specialist in all duties and 
activities for the maintenance of DVRS equipment.  These documents shall be considered 
collectively as the single official source of maintenance policy and direction authorized by Air 
Traffic Organization (ATO).  References located in the appropriate paragraphs of this handbook 
entitled Chapter 3, Standards and Tolerances, Chapter 4, Periodic Maintenance, and Chapter 5, 
Maintenance Procedures, shall indicate to the user whether this handbook and/or the equipment 
instruction book shall be consulted for a particular standard, key inspection element or 
performance parameter, performance check, maintenance task or maintenance procedure. 

 b. The latest edition of Order 6032.1, National Airspace System Modification Program, 
contains comprehensive direction concerning the development, authorization, implementation, and 
recording of modifications to facilities, systems, and equipment in commissioned status.  It 
supersedes all instructions published in earlier editions of maintenance technical handbooks and 
related directives. 

6.  FORMS LISTING.  In addition to forms required by Order 6000.15, an automated log is to be 
maintained at facilities that have remote maintenance monitoring capability. 

a.  Forms may be electronically downloaded from the FAA Electronic Forms Database located 
at http://feds.faa.gov. 

b.  A current Record of Changes is available at http://nas.amc.faa.gov/technical_library/ 
browse?view=list&type=mthb under the link for this order. 

7.  RECOMMENDATIONS FOR IMPROVEMENT.  Preaddressed comment sheets are 
provided at the back of this handbook.  The comment sheets may be mailed to: 

FAA/AJW-173 
P.O. Box 25082 
Mike Monroney Aeronautical Center 
Oklahoma City, OK 73125 

or returned to AJW-173 via interoffice mail.  Users may also submit recommendations for 
improvements to 9-Amc-AJW141TechDocServices@faa.gov. 
 
 
 
 
 

for Vaughn A. Turner 
Director, Safety and Operations Support 
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Chapter 1.  General Information and Requirements 
 
1-1.  Objective.  This handbook provides the necessary guidance to be used in conjunction with 
information available in instruction books and other handbooks for the proper maintenance of the 
Digital Voice Recorder System (DVRS). 

1-2.  Background.  Much of the information presented in this handbook was developed when 
supporting field personnel using operational DVRS equipment in the National Airspace System 
(NAS). 

1-3.  Recording Failure.  Appropriate Air Traffic (AT) personnel must be notified immediately 
in the event of any failure to record.  Several of the performance checks require that logger 
channels be taken out of service.  For some of the procedures, it is necessary to remove the entire 
logger from service.  Shutdown of any recorder logger(s) for maintenance, evaluation, or other 
purposes must be coordinated in advance with the appropriate personnel including AT.  Failure 
to record for any reason must be reported in accordance with agency orders. 

1-4.  Certification Requirements.  Refer to the latest edition of Order 6000.15, General 
Maintenance Handbook for National Airspace System (NAS) Facilities, for general guidance on 
the certification of systems, subsystems, and equipment.  Refer to Appendix A, Certification 
Requirements, of this handbook for the specific requirements of DVRS equipment. 

1-5.  Aircraft Accidents.  When aircraft accidents or incidents occur, Air Traffic Organization 
Technical Operations personnel are responsible, when requested by the Technical Operations 
Aircraft Accident Representative (AFAAR) through the appropriate control center, to evaluate 
and document the technical performance of the facilities which may have been involved (for 
some facilities, it may also be necessary to remove them from service and to conduct flight 
inspections).  This requires that facility operational data be obtained and recorded in the 
maintenance log and on technical performance records.  These records are official documents, 
and may be used by an aircraft accident investigation board in the determination of facility 
operational status at the time of the accident.  See the latest edition of Order 8020.16, Air Traffic 
Organization Aircraft Accident and Incident Notification, Investigation, and Reporting, for 
detailed guidance on requirements and activities following an aircraft accident/incident. 

Note:  If it is necessary to eject the digital audio tape (DAT) cartridge in the recorder to begin 
investigation of an accident/incident, ensure that the timeframe containing the accident/incident 
has been archived from the hard drive to the DAT drive.  The DVRS does not immediately 
archive information to the DAT cartridge.  It may take up to one hour to archive the last related 
recorded information pertaining to the accident/incident.  The information is still present on the 
recorder logger's hard drive and is available for playback. 

1-6.  Maintenance of Operating Equipment.  Maintenance on operating DVRS recorder 
equipment where such work may interfere with recording service operation must not be 
performed except in special cases, and then only when fully coordinated with all personnel 
concerned.  When a DVRS recorder logger is taken out of service for maintenance, basic actions 
are: 
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a.  Stop the recording of the affected logger. 

b.  Remove the DAT cartridges from the recorder logger. 

c.  Mark the DAT cartridge logbook to indicate that the cartridges were removed for 
maintenance purposes.  Refer to paragraph 1-23 for more information about creation and 
maintenance of the logbook. 

d.  The DAT cartridge must be stored in a secure locked location along with the logbook. 

1-7.  Reference to Agency Orders.  The following orders are referenced throughout this 
handbook: 

a.  Order 1100.5, FAA Organization – Field. 

b.  Order 1320.58A, Instructions for Writing Notices, Maintenance Technical Handbooks and 
System Support Directives. 

c.  Order 6000.15, General Maintenance Handbook for National Airspace System (NAS) 
Facilities. 

d.  Order 6032.1B, National Airspace System Modification Program. 

e.  Order 6200.4, Test Equipment Management Handbook. 

f.  Order JO 6640.2, Maintenance of Audio and Speech Equipment. 

g.  Order 6950.19, Practices and Procedures for Lightning Protection, Grounding, Bonding, 
and Shielding Implementation. 

h.  Order 7210.3, Facility Operation and Administration. 

i.  Order 8020.16, Air Traffic Organization Aircraft Accident and Incident Notification, 
Investigation, and Reporting. 

j.  Order 8200.1A, United States Standard Flight Inspection Manual. 

1-8.  Reference to Commercial Off the Shelf (COTS) Documentation.  The following 
documentation items are supplied with the DVRS equipment and must be available for use with 
the equipment: 

a.  MS-DOS® User’s Guide. 

b.  Microsoft® Windows™ User’s Guide. 

c.  TrueTime Global Positioning System (GPS) Receiver Manual. 

d.  Time Code Display Manual. 
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e.  Dual Stereo Cassette Recorder Manual. 

f.  Ethernet Hub Manual. 

g.  Smart-UPS® Manual. 

h.  Speaker System Manual. 

i.  DVRS – Air Traffic Quick Reference Guide. 

j.  TI 6670.11A, Instruction Book for Digital Voice Recorder System (DVRS). 

1-9.  Instruction Books and Drawings.  Instruction books and drawings for the DVRS 
equipment must be on hand where the DVRS equipment is located and readily available for use 
when required by system specialists.  Books and drawings must be revised as necessary to reflect 
all equipment modifications and documentation changes accomplished to date. 

1-10.  Storage of DVRS Software and Configuration Backup Disks.  All of the software 
media delivered with the DVRS equipment must be collected together and stored in a locked 
secure location where they are protected against extremes of heat, cold, moisture and exposure to 
magnetic or electrical fields.  Physical access to the software must be limited to the system 
specialist(s) responsible for maintenance of the DVRS equipment.  The storage location must be 
made known to all DVRS trained Technical Operations system specialists.  The local Technical 
Operations supervisor (or designee) must determine the means required for accessing the DVRS 
software media for maintenance activities. 

1-11.  Access to DVRS Equipment.  Access to DVRS equipment must not be provided to 
individuals who have not been trained in the use and operation of the DVRS equipment.  
Providing access to untrained individuals can lead to the following: 

a.  Disruption of DVRS service. 

b.  Loss of recordings. 

c.  Unpredictable workstation behavior. 

d.  Unpredictable logger behavior. 

e.  Corruption of recordings. 

f.  Corruption of workstation software. 

g.  Corruption of logger software. 

h.  Damage to the DVRS equipment. 
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1-12.  Administration of Users. 

a.  Assignment of User IDs/Passwords.  The local Technical Operations supervisor (or 
designee) is responsible for providing IDs/passwords to the standard users called for in this 
order. 

b.  Authorized Users.  Only users described in this order can have operational access to 
DVRS equipment. 

c.  Security of User IDs/Passwords.  The DVRS equipment uses user ID/password 
combinations to limit access to equipment functions.  User IDs/passwords for the DVRS 
equipment must only be provided to individuals who have a demonstrated need to know.  The 
user ID/password information must not be left in an unsecured state.  Should a change in 
personnel occur where an individual’s access to the DVRS equipment is no longer required or an 
ID/password combination becomes known to unauthorized personnel or suspected of 
compromise, the affected user ID(s)/password(s) must be changed immediately (on the recorder 
workstation as well as the reproducer and remote workstation).  The password for the user ID 
sysadm on the recorder workstation must not be the same as the password for the user ID sysadm 
on the reproducer or remote workstation in the facility.  Should the occasion arise where a 
system specialist has the responsibility for the maintenance of DVRS equipment at multiple 
facilities, the passwords must not be identical from facility to facility. 

d.  Recorder Workstation Users. 

(1)  System Administrator (@Rec).  The System Administrator (@Rec) has the user ID 
sysadm, which is preset by the software and cannot be modified except for the password.  The 
System Administrator user ID/password must only be issued to those DVRS trained Technical 
Operations system specialists who deal with the DVRS on a regular maintenance basis.  It is 
reserved for use only when configuring the software and performing troubleshooting or 
maintenance activities requiring its use.  It must not be used on a regular basis, nor must it be 
used for normal operation of the NiceLog Supervision program.  For those facilities where 
Technical Operations personnel are not on duty 24 hours a day, the System Administrator user 
ID/password may be issued to AT personnel who have received the appropriate DVRS training. 

(2)  Reproduce Only (@Rec).  The Reproduce Only (@Rec) user must be reserved to 
those DVRS trained individuals who are required to make copies of DAT cartridges at the 
recorder equipment.  At facilities where the reproducer equipment is not provided, the 
Reproduce Only (@Rec) user must be required to make certified re-recordings at the integrated 
recorder/reproducer (IRR) equipment.  The Reproduce Only (@Rec) user must not start the 
NiceLog Supervision program under normal operation. 

(3)  Monitor Only (@Rec).  The Monitor Only (@Rec) user must be provided to those 
DVRS trained individuals who need to monitor ongoing audio being recorded and playback 
audio information from the recorder logger(s) at the recorder workstation.  The Monitor Only 
(@Rec) user must start the NiceLog Supervision program at the recorder workstation. 
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e.  Reproducer Workstation Users. 

Note:  If the reproducer equipment is not networked to the recorder equipment, only the 
System Administrator has access to the information on DAT cartridges created on the non-
network recorder logger(s). 

(1)  System Administrator (@Rep).  The System Administrator (@ Rep) has the user ID 
sysadm, which is preset by the software and cannot be modified except for the password.  The 
System Administrator user ID/password must only be issued to those DVRS trained Technical 
Operations system specialists who deal with the DVRS on a regular maintenance basis.  It is 
reserved for use only when configuring the software and performing troubleshooting or 
maintenance activities requiring its use.  It must not be used on a regular basis.  For those 
facilities where Technical Operations personnel are not on duty 24 hours a day, the System 
Administrator user ID/password may be issued to AT personnel who have received the 
appropriate DVRS training.  Improper use of this user ID/password may lead to loss of the 
recording service.  Providing the network connection between the recorder equipment and the 
reproducer equipment eliminates the need for providing the System Administrator user ID/password 
for non-maintenance activities and will greatly reduce the risk of a loss of the recording service. 

(2)  Reproduce Only (@Rep).  The Reproduce Only (@Rep) user must be reserved for 
those DVRS trained individuals who are required to make cassette copies of audio information as 
part of their normally assigned duties. 

(3)  Recorder Monitor (@Rep).  The Recorder Monitor (@Rep) user must be provided 
to those DVRS trained individuals who need to monitor ongoing audio being recorded and 
playback audio information from the networked logger(s) at the reproducer workstation. 

(4)  Reproducer Shutdown.  The Reproducer Shutdown user must be provided to those 
DVRS trained individuals who need to power down the reproducer equipment.  This user, when 
set up properly, is not provided a means to shutdown the recorder loggers. 

f.  Remote Workstation Users. 

(1)  System Administrator (@Rem).  The System Administrator (@Rem) has the user 
ID sysadm, which is preset by the software and cannot be modified except for the password.  The 
System Administrator user ID/password must only be issued to those DVRS trained Technical 
Operations system specialists who deal with the DVRS on a regular maintenance basis.  It is 
reserved for use only when configuring the software and performing troubleshooting or 
maintenance activities requiring its use.  It must not be used on a regular basis.  For those 
facilities where Technical Operations personnel are not on duty 24 hours a day, the System 
Administrator user ID/password may be issued to AT personnel who have received the 
appropriate DVRS training. 

(2)  Recorder Monitor (@Rem).  The Recorder Monitor (@Rem) must be provided to 
those DVRS trained individuals who need to monitor ongoing audio being recorded and 
playback audio information from the networked recorder logger(s) at the remote workstation. 
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1-13.  Connection of Other Devices. 

a.  Connection of Computer Peripheral Devices.  Connection of additional computer 
peripheral devices (modems, printers, scanners, compact disk read only memory (CD-ROM) 
drives, hard drives, tape drives, monitors, other computers, networks, etc.) that were not supplied 
with the DVRS equipment is prohibited. 

b.  Installation of Additional Equipment.  Installation of adapters, circuit cards, equipment 
or other devices that are not part of the baseline DVRS equipment is expressly prohibited. 

c.  Connection of DVRS Equipment to Other Network(s).  Connection or interconnection 
of the DVRS equipment local area network (LAN) to any other network(s) is prohibited. 

1-14.  Connection of Equipment to DVRS Global Positioning System (GPS) Receiver. 

a.  The only equipment connected to the DVRS GPS receiver inter-range instrumentation 
group (IRIG) (IRIG-B or IRIG-E) or Serial I/O (RS-232) output port is as follows: 

(1)  The Time Code input of the recorder logger(s) must be connected to the main IRIG-B 
output of the GPS receiver. 

(2)  Type FA 10046/A Time Code Display (TCD) may be connected to the IRIG-B 
output of the GPS receiver. 

(3)  Type FA 10046 TCD may be connected to the IRIG-E output of the GPS receiver.  
The IRIG-E output is an optional feature not present on all GPS receivers. 

(4)  Datum Model 9520-240 TCD or TrueTime/Symmetricom 820-500 TCD provided 
with the DVRS reproducer and IRR can be temporarily connected to the GPS receiver IRIG-B 
outputs to verify an IRIG-B signal is present.  It must not be left connected to the GPS receiver. 

(5)  The Voice Switching and Control System (VSCS) in Air Route Traffic Control 
Centers (ARTCC), and/or the Low Level Wind-Shear Alert System (LLWAS), and/or the 
Automated Radar Terminal System 2E (ARTS 2E), and/or the CS-2330 Radio Communication 
Equipment (RCE) Centralized Maintenance System (CMS) may be connected to the Serial I/O 
(RS-232) output port of the GPS receiver directly or through the data broadcast unit DBU-232. 

b.  Connection of equipment other than the types listed specifically above is prohibited. 

1-15.  Interconnection of the Recorder and Reproducer or Remote Equipment.  The DVRS 
recorder and reproducer/remote equipment can be connected to allow access to the recorder 
logger(s) from the reproducer/remote workstation.  An audio cable and a network cable must be 
run between the systems.  Refer to chapter 7 for more information on interconnecting the 
equipment. 

1-16.  Use of Screen Savers.  Installation, configuration, or enabling of any screen saver 
software is expressly prohibited.  Screen saver software directly interferes with the operation of 
the NiceLog Supervision program. 
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1-17.  Use of Scheduled Recording Feature.  Scheduled Recording must be disabled for all 
facilities that are operational 24 hours a day.  If the facility is not operational 24 hours a day, the 
scheduled recording feature in NiceLog Supervision may be used to fulfill the requirement of 
FAA Order 7210.3, Facility Operation and Administration. 

1-18.  Operation of NiceLog Supervision Program.  The NiceLog Supervision program must 
be installed only on the recorder workstation and must remain active at all times.  The NiceLog 
Supervision is still operating when minimized.  A copy of the NiceLog Supervision program 
shortcut icon must be stored in the Windows™ StartUp program so that the program 
automatically starts when the Microsoft® Windows™ operating system starts. 

1-19.  BIOS/CMOS Features.  Modification of the settings available within basic input output 
system (BIOS) or complementary metal-oxide semiconductor (CMOS) creates operational 
conflicts with the DVRS equipment.  BIOS/CMOS settings of the workstation(s) and logger(s) 
must not be changed without consulting with the Oklahoma Communications Engineering Team 
(OKCET) AJW-173; refer to chapter 7 for field support contact information. 

1-20.  Use of DVRS Equipment for Purposes Other than Access to Recordings.  The DVRS 
equipment must only be used for the purpose of recording, monitoring, reproduction, playback 
and transcription of audio information related to Air Traffic control.  The workstations and 
loggers must not be used for any other purpose.  The computers that are part of the DVRS 
equipment suite are not to be used for administrative purposes.  This includes, but is not limited 
to, the recorder, IRR, reproducer, and remote workstations. 

1-21.  DAT Cartridge Changing Responsibility.  Most facilities will be able to fit recordings 
of one day (24 hours) onto a single DAT cartridge.  However, in some rare instances, it is 
possible for a DAT cartridge be filled with recordings of less than one day, and another cartridge 
will have to be inserted. 

a.  Air Route Traffic Control Centers (ARTCC) and Air Traffic Control System 
Command Center (ATCSCC).  The location of the recorder loggers at all centers must be in 
the operational equipment room.  Consequently, Technical Operations personnel must assume 
the responsibility for the changing, logging, and marking of DAT cartridges at these facilities. 

b.  Air Traffic Control Towers (ATCT), Terminal Radar Approach Control 
(TRACON), Radar Approach Control (RAPCON), Central Radar Approach (CERAP), 
and Flight Service Stations (FSS).  At locations where the recorder logger(s) are installed in 
remote equipment rooms, Technical Operations personnel must change, log, and mark DAT 
cartridges only during hours they are normally on duty.  Since a variety of individual conditions 
exist, arrangements between AT and Technical Operations must be made to fit the situation.  
Therefore, a mutually acceptable written memorandum of agreement (MOA) must be made by 
local AT and Technical Operations personnel assigning the responsibility for changing, marking, 
logging, and mounting DAT cartridges.  The written MOA must be on file in the facility.  
Factors such as duty hours of the system specialists and accessibility of the recorders to AT 
personnel must be carefully considered in arriving at a practical written agreement. 
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1-22.  Storage, Handling and Requisitioning of DAT Cartridges, DAT Cleaning Cartridges, 
Cassette Tapes and Cassette Tape Cleaning Cartridges. 

a.  Storage of DAT Cartridges.  The DAT cartridges are to be stored in a secure locked 
location. 

b.  Handling of DAT Cartridges. 

(1)  Only Digital Data Storage 2 (DDS-2) format, 120 meter DAT cartridges 
manufactured by Maxell, Sony, or Hewlett Packard can be used with the equipment. 

(2)  Use only labels contained in the original package provided with the new DAT 
cartridge to label the DAT cartridge and its protective case.  If labels are applied to the DAT 
cartridges improperly or improper labels are applied to DAT cartridges, the cartridges will 
become jammed in the DAT drive.  In many instances, the only way to remove a jammed DAT 
cartridge is to remove the DAT drive from the logger, causing a recording service outage. 

(3)  Use permanent black or blue ink to write on the labels.  Pencils must not be used. 

(4)  Do not use erasers (or eraser fluid) for changing markings on the DAT cartridge (the 
eraser crumbs/debris will severely damage the DAT drives and ruin the tape contained in the 
DAT cartridge).  Corrections can be made by drawing a single line through the error and writing 
the correct entry as space allows. 

(5)  Keep DAT cartridges in protective cases when they are not loaded into the logger 
DAT drive. 

(6)  The write-protect tab is not to be used on a regular basis for daily cartridge changes.  
Use the write-protect tab to protect accident/incident DAT cartridges from accidental erasure 
outside of the 15-day or 45-day archive life. 

(7)  Use the DAT cleaning cartridge before inserting an accident/incident DAT cartridge. 

(8)  Do NOT use DAT cartridges for more than 35 recording cycles.  Before disposing of 
DAT cartridges, erase and destroy non-accident/incident DAT cartridges that are outside the 15-
day or 45-day archive life. 

(9)  DAT cartridges may become damaged when exposed to electromagnetic fields. 

(10)  Damage will occur with the use of any chemicals on the DAT cartridges or the tape 
medium within the DAT cartridge. 

(11)  Do not expose DAT cartridges to direct sunlight or high temperatures. 

(12)  Do not expose DAT cartridges to dusty, dirty or smoky environments. 

(13)  Do not repair and reuse damaged DAT cartridges. 

(14)  Conventional DAT audio cartridges are not compatible with the DVRS. 
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c.  Requisitioning Responsibilities of Technical Operations and AT Personnel.  A 
mutually acceptable, written agreement between Technical Operations supervision and AT 
supervision must be on file in the facility that assigns responsibilities for the following tasks: 

(1)  Annual budgeting of funds for DVRS consumables (DAT cartridges, DAT cleaning 
cartridges, cassette tapes, and cassette tape cleaning cartridges). 

(2)  Requisitioning of DVRS consumables (DAT cartridges, DAT cleaning cartridges, 
cassette tapes, and cassette tape cleaning cartridges). 

(3)  Providing secure storage facilities for DAT cartridges and cassette tapes. 

(4)  The location of the logbook where DAT cartridge usage is documented. 

1-23.  DAT Cartridge Logbook.  A logbook that contains information for each DAT cartridge 
used with the DVRS equipment at the facility must be created and maintained.  The purpose of 
the logbook is to provide information about when and how a cartridge is used for recordings as 
well as the current whereabouts of any particular cartridge.  The logbook must be kept in the 
secure storage area with the DAT cartridges.  The logbook must contain at a minimum the 
following information for each DAT cartridge: 

a.  Unique DAT Cartridge Identifier.  Identify the DAT cartridge by creating identifiers 
using the facility site identifier combined with the logger number and a three digit number.  For 
example: ZHN101041; this cartridge is from site ZHN, logger number 101, and DAT cartridge 
number 041.  This identification method allows for easy identification of the DAT cartridges 
when they are shipped to other locations for processing.  It also allows the whereabouts of the 
DAT cartridge to be maintained in the DAT cartridge logbook. 

b.  DAT Drive Number.  The DAT drive number (1 or 2) that created the recordings on the 
DAT cartridge. 

c.  DAT Cartridge Start Recording Date/Time.  The Universal Coordinated Time (UTC) 
date and time when the DAT cartridge recordings begin. 

d.  Initials at DAT Cartridge Insertion.  The initials of the person who physically inserts 
the DAT cartridge into the DAT drive for recording. 

e.  DAT Cartridge Stop Recording Date/Time.  The UTC date and time when the DAT 
cartridge recordings stop. 

f.  Initials at DAT Cartridge Ejection.  The initials of the person who physically removes 
the DAT cartridge from the DAT drive at the end of its recording cycle and returns the DAT 
cartridge to the secure DAT cartridge storage area. 

g.  Comments Area.  The following actions require comments that must be noted in the 
logbook with appropriate explanations: 
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(1)  Erasure of DAT cartridge.  The reason the recordings were erased.  An example 
might be that the recordings were outside the archive life specified by the facility for this type of 
recording. 

(2)  Destruction of DAT cartridge.  The reason the cartridge was destroyed.  An example 
might be that the cartridge had exceeded its useful life. 

(3)  Introduction of new DAT cartridge.  The reason the cartridge was introduced.  An 
example might be that the cartridge in the sequence has a “Data too recent” error. 

(4)  Transfer of custody.  The reason the cartridge was removed from the secure DAT 
storage area.  An example might be that the cartridge has been assigned to Air Traffic for the 
investigation of an incident.  Another example might be when AT returns the DAT cartridge for 
reuse.  When custody of the DAT is to be transferred, the following information is required to be 
entered in the logbook for the particular DAT cartridge: 

(a)  The name of the person surrendering custody of the DAT cartridge. 

(b)  The agency, routing symbol and name of the person assuming custody of the 
DAT cartridge. 

(c)  The date and time the custody change took place. 

(d)  The reason for the change in custody. 

(e)  Where the DAT cartridge is being taken.  

(f)  When the DAT cartridge is expected to be returned. 

1-24.  Automatic Gain Control.  Air Traffic has determined the quality of recording must not 
be enhanced by the use of automatic gain control (AGC).  Recordings must be representative of 
what the controller heard at the time of the recording.  Accordingly, all DVRS equipment used 
for air traffic control communications recording must not use AGC anywhere in the recording 
path. 

1-25.  Recording of Telephone Lines and Central Office Lines (Trunks).  In many instances, 
there is a need to record telephone circuits in an AT facility.  FAA engineers and system 
specialists must consult national, state and local laws in addition to FAA rules and regulations 
prior to connecting telephone lines to the DVRS.  The connection of analog telephone lines to 
the DVRS equipment will not cause operational problems for the DVRS. 

1-26.  Diversity of Input Channels.  In the event of a recording failure or scheduled service 
outage, loss of recordings can be minimized by carefully planning audio channel input 
connections.  The input channels for the loggers are handled by the hardware in groups of 16 
channels.  For sites with more than 16 recorder channels and/or multiple recorder loggers, the 
following guidelines are provided to reduce the impact of a single logger failure or a partial 
hardware failure (for example an input channel group fails, but the logger(s) remains operational 
for the other input channels): 
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a.  Position Recording. 

(1)  Do not place a supervisory position for recording and its subordinate positions for 
recording on the same 16-channel group.  When multiple recorder loggers are available, 
supervisory positions should not be recorded on the same logger as their subordinate positions. 

(2)  Where more than one position is configured for the same purpose (example: 
northwest approach sector has two positions), every attempt must be made to place these 
positions on separate input channel groups.  When multiple recorder loggers are available, these 
types of channels should be placed on separate loggers. 

(3)  If multiple recorder loggers are available, it is desirable not to have individual 
loggers dedicated to position recording if frequency recording takes place on any of the other 
recorder loggers. 

b.  Frequency Recording. 

(1)  Do not place a frequency for recording on the same 16-channel group as the position 
using the same frequency.  When multiple recorder loggers are available, a frequency should be 
recorded on a separate logger from the position(s) using that frequency. 

(2)  Where more than one frequency is assigned for the same purpose (ultra-high 
frequency (UHF) and very-high frequency (VHF) operating together), every attempt must be 
made to place these frequencies on separate input channel groups.  When multiple recorder 
loggers are available, these types of channels should be placed on separate loggers. 

(3)  If multiple recorder loggers are available, it is desirable not to have individual 
loggers dedicated to frequency recording if position recording takes place on any of the other 
recorder loggers. 

1-27.  Transcription Preparation.  Facilities with reproducer equipment must not make 
transcriptions at the recorder workstation.  At facilities without reproducer equipment, 
transcriptions may be made at the recorder workstation by DVRS trained individuals.  Care must 
be exercised to avoid any impact to recording service.  The Microsoft® WordPad™ application 
accessed through the workstation (Program Manager – Accessories – WordPad) must be used to 
make transcriptions.  Transcriptions must never be stored on any DVRS workstation hard drive.  
They must be stored on floppy disks (3½-inch, formatted high-density (HD), 1.44 megabyte 
capacity) using the workstation floppy drive.  Any floppy disk used to make transcriptions must 
be new to avoid virus contamination.  Once a transcript is stored onto floppy disk, the floppy 
disk must be removed from the workstation floppy drive and taken to an administrative personal 
computer where the appropriate software for word processing can be used to format and print the 
finished transcript. 

1-28.  Unauthorized Software.  Unauthorized software must not be installed on any DVRS 
logger or workstation.  Use of unauthorized software with the DVRS equipment can lead to 
disruption of service, loss of recording, unpredictable workstation/logger performance, and 
corrupted recordings/software.  Refer to chapter 3 for the complete list of approved software for 
use on DVRS equipment. 
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1-29.  Interconnection of Loggers and Retrieval of Recordings.  DAT cartridges created on a 
logger carry that logger’s ID number internally (as data).  Because of this feature, access and 
retrieval of recordings on a DAT cartridge are dependent on the interconnection between the 
logger that created the DAT cartridge and the logger performing the retrieval.  The retrieval 
should be performed at reproducer equipment that is connected to the logger that created the 
DAT cartridge to reduce the risk of disruption to the recording service. 

a.  At a site where the recorder equipment and reproducer equipment are networked 
together. 

(1)  If the DAT cartridge is created locally at the same site and the DVRS user accounts 
are properly configured, DAT recordings must be retrieved onto the reproducer logger at the 
reproducer equipment using the ID and password of a Reproduce Only (@Rep) user ID. 

(2)  If the DAT cartridge is created at another site, retrieval of DAT recordings must be 
performed onto the reproducer logger at the reproducer equipment using the sysadm user ID.  
Only the System Administrator is able to access and/or retrieve DAT recordings created at a non-
networked logger.  Exercise care when using the System Administrator user ID as all of the 
equipment functions are available.  If procedures are not followed, a loss of recording service or 
DAT cartridge erasure could result. 

b.  At a site where the recorder equipment and reproducer equipment are not 
networked together.  Retrieval of DAT recordings must be performed at the reproducer 
equipment using the sysadm user ID.  Only the System Administrator is able to access and/or 
retrieve recordings on a DAT cartridge created at a non-networked logger.  Exercise care when 
using the System Administrator user ID as all of the equipment functions are available.  If 
procedures are not followed, a reproducer service outage or DAT cartridge erasure could result. 

c.  At a site without reproducer equipment. 

(1)  If the DAT cartridge is created at the same site, DAT recordings must be retrieved 
onto the original recorder logger using the Reproduce Only (@Rec) user ID. 

(2)  If the DAT cartridge is created at another site, retrieval of DAT recordings may be 
performed onto a recorder logger using the sysadm user ID.  Only the System Administrator is 
able to access and/or retrieve DAT recordings created at a non-networked logger.  Exercise care 
when using the System Administrator user ID as all of the equipment functions are available.  If 
procedures are not followed, a loss of recording service or DAT cartridge erasure could result. 

1-30.  Digital Copies of Original Recordings (DAT to DAT).  It is possible to copy portions of 
an original DAT cartridge to another DAT cartridge.  This copy process can only be 
accomplished by using the recorder logger that created the original DAT cartridge.  It cannot be 
performed at the reproducer logger. 
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1-31.  Backup of Site-Specific Configurations.  After the DVRS software has been configured 
in accordance with this handbook, configuration backup disks must be created.  The 
configuration backup disks may be used to quickly restore the logger or workstation software 
configuration.  The time required to restore equipment service after a software reload, logger 
hard drive replacement or workstation replacement is greatly reduced with configuration backup 
disks.  Configuration backup disks must be made prior to commissioning or after any 
maintenance activity that requires the software configuration to be changed.  Creation of a 
configuration backup disk for a recorder logger requires a service outage. 

1-32.  Nonstandard Facilities.  The instructions, descriptions, standards, tolerances, and 
procedures contained in this order represent the agency's baseline and standard criteria 
concerning DVRS equipment.  Some facilities may have been commissioned using equipment 
procured without the benefit of using agency-approved specifications.  The latest edition of 
Order 1100.5, FAA Organization – Field, prohibits regional procurement of equipment and 
devices to be used for air traffic control or navigation for which specifications have not received 
prior agency approval.  The inclusion of such nonstandard equipment in this order is for 
maintenance purposes only, and, as such, must not be used as justification for procurement, 
installation, or commissioning of unapproved equipment. 

1-33.  Software Virus Protection of the DVRS.  The DVRS system is a computer-based, 
computer-controlled recording system, and, as such, it can be vulnerable to software viruses.  
When following the procedures of this order and TI 6670.11A, extreme care must be taken to 
ensure the operational system is not virus-contaminated. 

1-34.  Maintenance Precautions.  The system specialist must be aware of the following 
precautions before proceeding with maintenance and adjustment of the equipment. 

a.  Lock recordings.  The DVRS provides the capability to lock recordings, which prevents 
the recording from being automatically erased.  It is possible to lock recordings on actively 
recording channels.  A locked active recording will continue to grow until the hard drive is full, 
forcing the logger to stop recording new audio.  A recording must have a definitive stop time 
prior to locking.  It is necessary to momentarily stop recording to force a definitive stop time. 

b.  Shutdown logger.  If the logger (recorder or reproducer) software is not shutdown 
properly prior to the removal of power (or using the reset button) from the logger, corruption of 
the logger’s hard drive occurs.  Each logger must have its software shutdown from the NiceLog 
Voice Logger software application Maintenance menu before the logger power is cycled off (or 
the reset button is pressed).  Failure to do so will lead to loss of recordings and loss of the 
recording service.  In addition, improper shutdown of the logger will result in damage to any of 
the DAT cartridge(s) in the DAT drives at the time of power loss or logger reset. 

c.  Shutdown workstation.  If the workstation (recorder, IRR or reproducer) Microsoft 
WindowsTM operating system software is not shutdown properly (completely exit WindowsTM) 
prior to the removal of power (or using the reset button) from the workstation, corruption of the 
workstation’s hard drive occurs.  This corruption could affect the Windows file structure, and/or 
the contents of files on the hard drive.  Failure to observe this precaution can lead to loss of 
recording service and/or loss of operation of the workstation. 
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d.  Move logger.  The hard drive in the logger can be damaged if the logger (recorder or 
reproducer) is moved while ac power is applied to the unit. 

e.  Format hard drive.  The hard drives used in the loggers and workstations must never be 
low level formatted using the BIOS format routine. 

f.  Electrostatic discharge (ESD).  ESD precautions must be observed at all times when 
performing maintenance or making repairs to any portion of the DVRS (recorder or reproducer).  
An anti-static wrist strap must be worn at all times when servicing equipment in the DVRS 
cabinet frame (rack).  When servicing the reproducer equipment, the wrist strap must be clipped 
to the chassis of the equipment in question.  Failure to use the anti-static wrist strap properly can 
cause injury to the system specialist and/or damage to the equipment. 

g.  Jumper settings.  Some of the lowest replaceable unit (LRU) components that comprise 
the DVRS equipment suite use jumpers to define LRU behavior.  The jumpers must be correctly 
set for proper operation.  Refer to TI 6670.11A, volume III for the correct LRU jumper settings. 

h.  Computer monitor.  Monitors that were not supplied as part of the DVRS equipment 
must not be connected to any of the DVRS equipment.  Monochrome, color graphics array or 
enhanced graphics array monitors must not be used for any purpose with the DVRS equipment.  
Use of incorrect monitors has led to false error message generation by DVRS equipment. 

i.  DAT drive.  The DVRS DAT drives are highly sensitive to dust and dirt.  For this reason, 
the front logger doors must remain closed at all times (except for removal and insertion of DAT 
cartridges).  Failure to adhere to this precaution will lead to damaged DAT cartridges and 
permanently damaged DAT drives.  The environment where the equipment is located must be as 
dust free as possible.  Damage may result when attempting to use DAT drives when the ambient 
temperature of the environment is outside the temperature range of 40 °F to 89 °F (5 °C to 
35 °C). 

j.  Eject DAT cartridge.  The ejection buttons located on the DAT drives of the loggers 
(recorder and reproducer) must not be used for the ejection of DAT cartridges.  If the buttons are 
used, they cause the cartridges to be immediately ejected without giving the logger software the 
opportunity to properly close down the archiving process.  This leads to portions of the DAT 
cartridge being unusable, resulting in loss of recordings.  These DAT cartridges may indicate 
DAT media failure errors when retrieval is attempted.  If the DAT cartridge is manually ejected, 
it can cause SCSI errors and loss of recording service.  Manual ejection of a DAT cartridge must 
only be attempted when the software methods provided are not successful after having been tried 
repeatedly. 

k.  Insert/remove DAT cartridge.  Excessive force during insertion or removal of a DAT 
cartridge leads to DAT drive damage, DAT cartridge damage, and/or jammed cartridges in the 
DAT drive.  Wait until the drive has completed the ejection cycle before removing the DAT 
cartridge. 
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Chapter 2.  Technical Characteristics 
 
2-1.  Purpose or Function.  The Digital Voice Recording System (DVRS) equipment provides 
recording service to facilities throughout the National Airspace System (NAS) and the 
Department of Defense (DOD).  The recording of all controller/pilot air traffic control (ATC) 
communications is required to ensure that adequate records are kept in the event of aircraft 
accidents or incidents and to improve pilot/controller communication techniques.  Recording 
ATC conversations is generally accomplished on a controller position basis.  Frequency 
recording is provided where sufficient recording equipment (recorder input channels) is 
available.  Refer to Order 7210.3, Facility Operation and Administration, for detailed 
information on the priority of position recording versus frequency recording. 

2-2.  Overview.  The DVRS equipment is a computer driven, software based system that 
employs digital technologies for voice recording.  It is composed of commercial off the shelf 
(COTS) hardware, firmware, and software.  Recording is accomplished on the recorder logger(s).  
Each logger can have 16, 32, or 48 input channels.  Multiple recorder loggers may be networked 
through a dedicated local area network (LAN) to increase channel capacity beyond 48.  
Recordings are archived to Digital Audio Tape (DAT) cartridges that are retained in accordance 
with the latest edition of Order 7210.3.  When a logger is properly configured and under normal 
operating conditions, one DAT cartridge is sufficient to store recordings of an entire day for all 
channels on the logger.  Although rare, in some circumstances high channel activity may cause 
the logger to utilize more than one DAT cartridge per day.  The recorder logger(s) uses an Inter-
Range Instrumentation Group format B (IRIG-B) time code signal provided by a global 
positioning system (GPS) receiver to time stamp recordings as they are being recorded.  
Facilities that have integrated recorder/reproducer (IRR) equipment or reproducer equipment are 
capable of creating audio cassette copies of recordings. 

2-3.  Description of DVRS Configurations.  There are four configurations of DVRS equipment, 
including the recorder system, reproducer system, IRR system, and remote workstation.  Each 
facility is installed with either a reproducer system or an IRR system, but not both.  The four 
configurations are described in the following text. 

a.  Recorder System.  The recorder system is used to provide recording service.  The 
recorder system is located in the facility equipment room.  The major components that comprise 
the recorder system include: 

(1)  GPS receiver.  This unit receives coded time signals sent by the GPS satellites.  The 
time information is converted to IRIG-B and is outputted to the logger(s) where it is used to 
place a time stamp on the audio recordings.  Some GPS receivers are equipped with an optional 
interface that has the capability of outputting IRIG-E signals compatible with type FA-10046 
Time Code Displays (TCD).  The time displayed and outputted by the GPS receiver is 
synchronized with Universal Coordinated Time (UTC). 
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(2)  Recorder logger.  The recorder logger is a rack mounted industrial computer-based 
system that does not need a monitor or keyboard for normal operation.  The logger digitizes up to 
48 audio inputs and stores up to 128 channel hours of information on a hard drive.  The recorded 
audio is archived onto a DAT cartridge, which holds up to 500 channel hours, for long-term 
storage.  The logger utilizes COTS computer components to perform the basic computing 
functions and specialized components to provide recording capability.  For detailed information 
about the various components that comprise the logger, consult TI 6670.11A, Instruction Book 
for Digital Voice Recorder System (DVRS). 

(3)  Recorder workstation.  The recorder workstation, including the computer, mouse, 
rack mountable keyboard and monitor, is the user interface to the recorder logger(s) via the 
DVRS LAN.  It is used to monitor and control the recorder logger(s).  The recorder workstation 
contains an alarm relay card that will activate the remote alarm in the event of a failure. 

(4)  Remote alarm.  This unit provides an audible and visible indication in the event of a 
DVRS failure. 

(5)  Ethernet 10BaseT network hub.  This unit is used to network the DVRS recorder 
workstation, recorder logger(s) and reproducer equipment. 

(6)  Recorder speakers.  The recorder speakers are directly connected to the audio outputs 
of the recorder loggers.  They are used to monitor the audio of the ongoing recordings or the 
playback of the recordings from the logger hard drive. 

(7)  Uninterruptible Power Supply (UPS).  This unit provides limited power conditioning 
to DVRS equipment racks connected to the essential power bus.  Its intended purpose is to 
provide up to 15 minutes of uninterrupted ac power to the equipment in the event of a power 
outage or when switching from commercial power to engine generator power (and vice versa).  
An UPS is not provided to Air Route Traffic Control Centers (ARTCCs) where the DVRS is 
connected to the critical power bus. 

b.  Reproducer system.  The reproducer system is used for reproduction of original 
recordings made on the recorder system and/or investigation of accidents/incidents.  The 
reproducer is also used to meet agency administrative needs such as fulfillment of Freedom of 
Information Act (FOIA) requests, legal evidence, accident/incident investigation packages and 
training.  The major components that comprise the reproducer system include: 

(1)  Reproducer logger.  The reproducer logger is a rack mountable industrial computer-
based system that does not need a monitor or keyboard for normal operation.  This logger is used 
for reproduction purposes only, and therefore, does not use any audio inputs.  The reproducer 
logger is used to retrieve recordings containing audio and time code from a DAT cartridge to the 
logger hard drive.  The recordings can then be played back or recorded to a cassette cartridge.  
The logger utilizes COTS computer components to perform the basic computing functions and 
specialized components to provide reproducing capability.  For detailed information about the 
various components that comprise the reproducer logger, consult TI 6670.11A.  The reproducer 
logger utilizes the same components as the recorder logger in a different configuration.  The 
major differences include: 
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(a)  The reproducer logger has only one DAT drive. 

(b)  The reproducer logger contains only one Analog Digital Interface/Analog Line 
Interface (ADIF/ALI) pair. 

(c)  The software limits the number of input channels to 8. 

(2)  Reproducer workstation.  The reproducer workstation, including the computer, mouse, 
keyboard and monitor, is the user interface to the reproducer logger and networked recorder 
logger(s) via the DVRS LAN.  It is used to monitor the networked recorder loggers and control 
the reproducer logger. 

(3)  Ethernet 10BaseT network hub.  This unit networks the DVRS reproducer workstation, 
reproducer logger and recorder equipment. 

(4)  Dual channel cassette recorder/player.  This unit is used to record the recordings from 
the hard drive of the networked loggers (recorder and reproducer) onto cassette cartridges, as 
well as playback recordings from cassette cartridges.  The audio of the recordings is placed on 
the left channel, and the time code of the recordings is placed on the right channel of the cassette 
cartridge. 

(5)  Reproducer speakers.  The reproducer speakers are connected to the left channel audio 
output of the cassette recorder/player.  They output the audio from the networked loggers (recorder 
and reproducer) or from the cassette recorder/player. 

(6)  TCD.  This unit converts an IRIG-B signal received from the cassette recorder/player 
or the logger to a visual digital form. 

c.  Integrated Recorder/Reproducer (IRR) system.  In place of a stand-alone reproducer 
system, some sites have a hybrid system that merges recorder system and reproducer system 
capabilities into one system called an IRR.  The IRR consists of all of the recorder system 
equipment, the dual channel cassette player/recorder, and the TCD.  The major components that 
comprise the IRR system include: 

(1)  GPS receiver.  This unit receives coded time signals sent by the GPS satellites.  The 
time information is converted to IRIG-B and is outputted to the logger(s) where it is used to 
place a time stamp on the audio recordings.  Some GPS receivers are equipped with an optional 
interface that has the capability of outputting IRIG-E signals compatible with type FA-10046 
TCDs.  The time displayed and outputted by the GPS receiver is synchronized with UTC. 

(2)  IRR logger.  The IRR logger (also called the recorder logger) is a rack mounted 
industrial computer-based system that does not need a monitor or keyboard for normal operation.  
The logger digitizes up to 48 audio inputs and stores up to 128 channel hours of information on a 
hard drive.  The recorded audio is archived onto a DAT cartridge, which holds up to 500 channel 
hours, for long-term storage.  The logger utilizes COTS computer components to perform the 
basic computing functions and specialized components to provide recording and reproducing 
capabilities.  For detailed information about the various components that comprise the logger, 
consult TI 6670.11A. 
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(3)  IRR workstation.  The IRR workstation (also called the recorder workstation), 
including the computer, mouse, rack mountable keyboard and monitor, is the user interface to the 
IRR logger(s) via the DVRS LAN.  It is used to monitor and control the IRR logger(s).  The IRR 
workstation contains an alarm relay card that will activate the remote alarm in the event of a 
failure. 

(4)  Remote alarm.  This unit provides an audible and visible indication in the event of a 
DVRS failure. 

(5)  Ethernet 10BaseT network hub.  This unit is used to network the DVRS IRR 
workstation and IRR logger(s). 

(6)  Dual channel cassette recorder/player.  This unit is used to record the recordings from 
the hard drive of the IRR logger(s) onto cassette cartridges, as well as playback recordings from 
cassette cartridges.  The audio of the recordings is placed on the left channel, and the time code 
of the recordings is placed on the right channel of the cassette cartridge. 

(7)  IRR speakers.  The IRR speakers are connected to the left channel audio output of the 
cassette recorder/player.  They are used to monitor the audio of the ongoing recordings or the 
playback of the recordings from the logger hard drive or cassette recorder/player. 

(8)  TCD.  This unit converts an IRIG-B signal received from the cassette recorder/player 
or the logger to a visual digital form. 

(9)  UPS.  This unit provides limited power conditioning to DVRS equipment racks 
connected to the essential power bus.  Its intended purpose is to provide up to 15 minutes of 
uninterrupted ac power to the equipment in the event of a power outage or when switching from 
commercial power to engine generator power (and vice versa). 

d.  Remote Workstation.  The remote workstation is site-optional.  It allows playback and 
monitoring from a remote location such as the control room.  The major components of the 
remote workstation are a reproducer workstation and speakers.  The remote workstation option 
must be procured from Northrop Grumman Electronic Systems (also known as Denro).  A 
licensed copy of the workstation software is included with the workstation. 

2-4.  Audio/Time Code Flow Theory of Operation. 

a.  Description of Input Audio/Time Code Flow.  The following paragraphs outline the 
audio and time code path during the recording process.  Refer to figure 2-1 for the audio/time 
code flow diagram within the logger. 

(1)  The IRIG-B time code signal is supplied by the GPS receiver input through the 
Logger Auxiliary Function Input/Output (LAF I/O) board to the LAF board.  The LAF board 
decodes the IRIG-B signal and updates the logger internal clock. 

(2)  Analog audio signals are input to the logger ALI board(s) via 50 pin twisted pair 
cables. 



12/03/2008 JO 6670.13A 
 

2-5 

Figure 2-1.  Audio/Time Code Flow Diagram within the Logger 
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Note:  The audio source (mixing amplifiers, voice switch equipment, control consoles, etc.) is 
connected to 66-block(s) within the DVRS equipment rack.  The audio is then routed from the 
66-block(s) to the logger ALI board(s).  Each audio input channel is terminated with 600 Ω 
resistors on the 66-block.  The resistors must be in place to match the output impedance of the 
audio source. 

(3)  The signals are transferred from the ALI board(s) to the ADIF board(s) via the analog 
bus. 

(4)  The incoming analog audio signals are converted to digital format on the ADIF 
board(s).  The ADIF determines if audio is present by comparing the digitized audio level to the 
user-established threshold level for that channel.  If the audio input level is below the threshold, 
the audio information is discarded.  The logger continues to keep track of time so that the silent 
periods can be recreated during playback. 

(5)  If Monitor is selected for the channel, the following steps are also completed. 

(a)  The digitized audio is passed to ADIF board one. 

(b)  ADIF board one converts the audio back to analog format and sends it to the LAF 
board via the analog bus, where it is available on a user-selected output. 

(c)  The LAF board converts the time back to IRIG-B format and sends it to the LAF 
I/O time code output. 

(6)  The digitized audio is passed to the Audio Processing Array (APA) board through the 
Multi-Vendor Interface Protocol (MVIP) bus for advanced processing. 

(7)  The digitized audio is passed back to the ADIF board(s) for compression (mandated 
to Adaptive Differential Pulse Code Modulation (ADPCM) 16). 

(8)  The digitized time signal leaves the LAF board via the Industry Standard 
Architecture (ISA) bus to the ADIF board(s). 

(9)  The compressed audio/silence combined with the digitized time signal are sent to the 
Small Computer System Interface (SCSI) controller through the ISA bus on the backplane.  The 
process is coordinated and controlled by the NiceLog logger software. 

(10)  The SCSI controller passes the digitized audio and time code to the hard drive. 

(11)  At regular intervals (approximately every 15 minutes) audio and time code 
information is archived (copied) from the logger hard drive to DAT cartridge.  By archiving 
audio at a regular interval, the DAT drive is not in use 100 percent of the time, thereby greatly 
extending its life. 



12/03/2008 JO 6670.13A 
 

2-7 

(12)  Once the information has been successfully archived from the hard drive to the 
DAT cartridge, the disk space it occupied on the hard drive is marked as available for new-
recorded information.  The information is not deleted from the hard drive until the recorder 
software determines that this particular audio is the oldest audio on the hard drive, and that 
additional storage space is necessary.  This allows for playback of audio that has previously been 
recorded and archived to the DAT cartridge earlier in the day without needing to retrieve the 
information from the DAT cartridge. 

Note:  When monitoring incoming audio to the recorder using the monitor feature, the audio 
reaching the speaker appears to be clipped at the beginning of some audio segments.  This is a 
normal and consistent feature of the NiceLog Voice Logger.  The system is designed to hold 
the monitored sound until the programmed threshold is exceeded.  This sound is held in a 
buffer and processed against the programmed threshold.  The threshold is tested for a full audio 
buffer, and about a one second delay in the start of sound is noticed during monitoring of audio 
to the recorder between audio segments where silence has been detected.  This clipped effect 
does not interfere with the proper recording of audio. 

b.  Description of Output Audio/Time Code Flow.  The following paragraphs outline the 
audio and time code path during the playback process.  Refer to figure 2-1 for the audio/time 
code flow diagram within the logger. 

(1)  Recorded data (audio and time code) can only be played from a logger hard drive.  
To play back recorded data from a DAT cartridge, it must first be retrieved to the logger hard 
drive. 

(2)  When a recording is located on the hard drive, the user issues a playback command to 
the software.  The SCSI controller requests and receives the recorded data from the hard drive. 

(3)  The SCSI controller sends the data to the APA.  At the APA, the recorded data is 
separated into audio data and time stamps.  Advanced process of the audio data is performed, 
such as automatic gain control (AGC) in playback.  The time stamps are used at the LAF to 
generate time code. 

(4)  The audio data and time stamps are transferred via the MVIP bus to ADIF board one.  
The ADIF converts the digital audio signal into an analog audio signal. 

(5)  The audio data and time stamps are transferred from the ADIF to the LAF board 
separately via ribbon cable.  The LAF card associates the time stamps with the audio and then 
generates the IRIG-B time code signals.  The LAF also performs the audio summation, if that 
feature is used. 

(6)  The time code signal is subsequently sent from the LAF board to the LAF I/O board.  
Analog audio is available on the LAF board through a user-selected output. 

Note:  The audio and time code are only associated when the audio is played from LAF output 
#1. 



12/03/2008 JO 6670.13A 
 

2-8 

(7)  To hear the audio and see the associated time, the workstation speakers and TCD 
must receive audio from LAF output #1 and time code signal from LAF I/O port J3, respectively.  
The audio and time signals are connected through the dual channel cassette recorder/player with 
the audio on the left channel and the time on the right channel. 

Note:  Audio alone or audio with time code may be connected to a reproducer or remote 
workstation.  Refer to chapter 7 for more information regarding the equipment interconnection. 

c.  Time Source Recording.  The DVRS uses the IRIG-B time code signal provided by the 
GPS receiver to time stamp the recorded audio.  There is not a separate track or channel reserved 
for time recording as with the agency older style analog reel-to-reel recorders.  During playback, 
these time stamps are retrieved with the recorded audio.  The audio is presented over the speaker 
system, and the time code is displayed visually on the workstation monitor and/or time code 
display (if present).  No audio channel of the DVRS must be reserved or used to record the IRIG-
B signal. 

Note:  When making a cassette copy, audio information (voice) is always placed on the left 
channel of the cassette tape, and the IRIG-B (time) information is always placed on the right 
channel of the cassette tape. 

2-5.  DVRS Fail-Safe/Alarm Theory of Operation. 

a.  The recorder workstation has an alarm relay card installed in it.  This card contains a relay 
that is activated by the NiceLog Supervision program in an alarm condition.  The relay passes 12 
Volts from an external power supply to the external alarm box.  Alarm operation is controlled by 
the Supervision program on the recorder workstation.  The Supervision program must be in 
operation and properly configured for the alarm system to function.  If not, alarm capability is 
disabled.  Most hardware failures will cause an external alarm.  Refer to TI 6670.11A, volume II 
for details of the specific events and/or failures that can be configured to trigger an alarm. 

b.  Certain failures of the equipment do not provide alarm/fail-safe capability.  The following 
is a partial list of failures that cannot be detected automatically at this time: 

(1)  Failure to record audio as a result of direct software intervention by personnel with 
access to the recorder workstation. 

(2)  Most workstation failures will not trigger an alarm.  In general, workstation failures 
do not cause a recording service outage. 

(3)  Software problems such as a corrupt logger database are not always detected. 

c.  For each channel, the logger keeps activity statistics based on the percentage of time the 
channel is active (i.e. the audio level exceeds the threshold for that channel).  Each channel can 
be individually configured to trigger an alarm if channel activity is outside of parameters set by 
the user.  This feature is useful for detecting problems and/or troubleshooting.  For example, a 
low statistics alarm on a channel that is normally active may indicate an open circuit.  On the 
other hand, high statistics may indicate crosstalk or excessive noise on that channel.  Refer to 
TI 6670.11A, volume II for further details concerning statistics alarms. 
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2-6.  Audio File Theory of Operation. 

Note:  This theory of operation discussion assumes the DVRS logger software has been 
configured in accordance with this order. 

a.  Audio is stored on the hard drive in 1800 audio files that are always present.  Each audio 
file is the same size.  The logger writes incoming audio to the audio files.  When an audio file is 
full, the logger begins writing to the next available audio file.  The logger uses an internal 
database to track which times and channels were placed in which audio files.  Loggers are 
configured to delete the oldest audio.  Therefore, after all audio files have been used, the oldest 
available audio files are overwritten.  In normal operation, audio will be written to the DAT 
cartridge before it is overwritten on the hard drive. 

b.  With the compression configured for ADPCM16, each audio file holds a maximum of 4 
minutes and 16 seconds of compressed audio (after the silence has been removed).  The 4 
minutes and 16 seconds of compressed audio will translate into more than 4 minutes and 16 
seconds of real-time audio when decompressed (silence reinserted).  The 1800 audio files can 
hold a maximum of 128 channel hours of compressed recordings. 

c.  To ensure audio is promptly archived to a DAT cartridge, the system uses the following 
rules to determine when audio is archived: 

(1)  Audio is archived to the DAT when the audio file on the hard drive is full. 

(2)  An audio file that contains audio but is not full will be closed and archived to DAT 
within 30 minutes. 

(3)  An audio file that contains only silence will not be closed or archived to DAT. 

d.  Because of the method used to archive audio, the start/stop times on DAT cartridges will 
not coincide directly with the cartridge eject time.  Only closed audio files (that were not 
previously archived to another DAT cartridge) will be present on the ejected DAT cartridge.  
Therefore, up to 30 minutes of recordings before cartridge ejection may not be present on the 
ejected DAT cartridge.  The missing recordings will be present on the next day DAT cartridge.  
If a channel had complete silence throughout the day, no recordings for that channel will be 
present on the ejected DAT cartridge. 

2-7.  DAT Cartridge Operations and Data Retention. 

a.  Archive Life. 

(1)  When a DAT cartridge is inserted, the logger immediately writes the current UTC 
date to the DAT cartridge.  This date is called the “Created Date.”  The logger calculates the 
archive life expiration date of the DAT cartridge by adding the overwrite setting to the created 
date (refer to paragraph 5-11a(6) and figure 5-36 for the mandated overwrite settings).  Both the 
created and expiration dates are stored on the DAT cartridge.  Therefore changing the overwrite 
setting will not affect the ability to overwrite a previously recorded DAT cartridge. 
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(2)  Order 7210.3 and Order 8020.16, Air Traffic Organization Aircraft Accident and 
Incident Notification, Investigation, and Reporting, require that air traffic control facilities retain 
recorded voice communication data for 45 days.  Facilities that retain all voice communication 
data for 15 days are those utilizing system analysis recording cartridges as their radar retention 
media (regardless of the type of voice recorder system being used), those utilizing an analog 
voice recorder system, and the David J. Hurley Air Traffic Control System Command Center.  
The DAT expiration is calculated based on the date the cartridge was inserted regardless of the 
cartridge contents.  In addition, the Oklahoma Communications Engineering Team (OKCET) has 
discovered that for an overwrite setting greater than 30 days, the DAT will not be overwritten 
until one day after the expiration date.  To compensate for the difference between the FAA 
retention requirements and the DVRS calculations, the DVRS overwrite setting will vary from 
17 or 46 days depending on the facility.  Refer to TI 6670.11A, volume III for more information 
on DVRS calculations and overwrite settings. 

(3)  In some cases, a DAT cartridge is ejected the same day it was inserted.  Due to the 
overwrite setting, the cartridge will not be overwritten until 46 days have passed.  The cartridge 
must be manually erased after 45 days. 

b.  Storage Capacity of the Hard Drive and DAT Cartridges. 

(1)  At a compression setting of ADPCM16, a Digital Data Storage 2 (DDS-2) DAT 
cartridge will hold up to 500 channel hours of audio.  The hard drive will hold up to 128 channel 
hours. 

(2)  In rare instances, depending on the number of channels and activity rate, some 
facilities may require more than one DAT cartridge per day.  For example, a 48-channel logger 
with 50% channel activity will use (48 channels x 24 hours x 0.5) 576 channel hours in one day. 

c.  DAT to DAT Copy.  Every recording is stamped with the logger number that created it.  
Both the logger number and the recording are stored on the DAT cartridge.  The logger software 
has a built-in security feature that prevents audio recorded on a different logger from being 
archived.  Therefore, a DAT to DAT copy of recordings must be completed on the logger that 
made the original recordings. 
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Chapter 3.  Standards and Tolerances 
 
3-1.  General.  This chapter prescribes the standards and tolerances for the Digital Voice 
Recorder System (DVRS) equipment as defined and described in Order 6000.15, General 
Maintenance Handbook for National Airspace System (NAS) Facilities.  All key performance 
parameters are clearly identified by an arrow ( ) placed to the left of the applicable item. 

3-2.  – 3-10.  Reserved. 

Section 1.  Equipment Performance and Settings 
 

Tolerance/Limit 
Parameter Reference

Paragraph Standard 
Initial Operating 

     

3-11.  Time Correctness.     

a.  GPS receiver ........................  5-6a On time On time On time 

b.  Recorder/IRR workstation ....  5-6b On time ± 1 second ± 3 minutes 

c.  Recorder logger(s) ...............  5-6c On time On time ± 1 second 

d.  Reproducer/remote 
workstation .......................................  

5-7a On time ± 1 second ± 3 minutes 

e.  Reproducer logger................  5-7b On time ± 1 second ± 3 minutes 

3-12.  Playback Voice Quality.     

a.  Recorder ...............................  5-8 Acceptable 
intelligibility 

Acceptable 
intelligibility 

Acceptable 
intelligibility 

b.  Reproducer...........................  5-9 Acceptable 
intelligibility 

Acceptable 
intelligibility 

Acceptable 
intelligibility 

3-13.  NiceLog Software Settings.     

a.  Recorder/IRR workstation ....  5-10 Exact setting 
match 

Exact setting 
match 

Exact setting 
match 

b.  Recorder logger(s) ..............  5-11 Exact setting 
match 

Exact setting 
match 

Exact setting 
match 

c.  Reproducer/remote 
workstation .......................................  

5-12 Exact setting 
match 

Exact setting 
match 

Exact setting 
match 

d.  Reproducer logger................  5-13 Exact setting 
match 

Exact setting 
match 

Exact setting 
match 

3-14.  Remote Alarm Operation ....  5-16 All functions All functions All functions 

3-15.  UPS Condition......................  5-18 Acceptable Run 
Time 

Acceptable Run 
Time 

Acceptable Run 
Time 

3-16.  GPS Receiver Settings ........  5-29 Exact setting 
match 

Exact setting 
match 

Exact setting 
match 
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Section 1.  Equipment Performance and Settings (Continued) 
 

Tolerance/Limit 
Parameter Reference

Paragraph Standard 
Initial Operating 

     
3-17.  GPS Time Code Format and 
Signal Levels ..................................  

5-30 1 KHz amplitude 
modulated IRIG-
B, 5.0 ± 1 Vp-p 

for high,  
1.5 ± 0.2 Vp-p for 

low. 

1 KHz amplitude 
modulated IRIG-
B, 5.0 ± 1 Vp-p 

for high,  
1.5 ± 0.2 Vp-p for 

low. 

1 KHz amplitude 
modulated IRIG-B, 

5.0 ± 1 Vp-p for 
high,  

1.5 ± 0.2 Vp-p for 
low. 

3-18.  Recorder Logger 
Performance Characteristics. 

    

a.  System gain..........................  5-31c 0 dB ± 3 dB ± 3 dB 

b.  Audio frequency response....  5-31d ± 3 dB from 300 
Hz to 2700 Hz 

± 4 dB from 300 
Hz to 2700 Hz 

± 4 dB from 300 
Hz to 2700 Hz 

c.  Noise-with-tone.....................  5-31e 35 dBrnC 
maximum 

35 dBrnC 
maximum 

35 dBrnC 
maximum 

3-19.  Reproducer Logger 
Performance Characteristics. 

    

a.  Audio frequency response....  5-32d ± 3 dB from 300 
Hz to 2700 Hz 

± 4 dB from 300 
Hz to 2700 Hz 

± 4 dB from 300 
Hz to 2700 Hz 

b.  Noise-with-tone.....................  5-32e 35 dBrnC 
maximum 

35 dBrnC 
maximum 

35 dBrnC 
maximum 

3-20.  Cassette Player/Recorder 
Channel Assignments. 

    

a.  Audio signal ..........................  N/A Left channel Left channel Left channel 

b.  Time signal ...........................  N/A Right channel Right channel Right channel 

3-21.  Calibrate Cassette 
Player/Recorder..............................  

5-34 0 dB @ -10 dBm 
tone 

± 3 dB @ 
-10 dBm tone 

± 3 dB @ -10 dBm 
tone 

3-22.  Cassette Player/Recorder 
Performance ...................................  

5-35 Acceptable 
intelligibility 

Acceptable 
intelligibility 

Acceptable 
intelligibility 

3-23.  – 3-30.  Reserved.     
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Section 2.  Equipment Software Versions 
 

Software Platform Software Item/Title 
(Quantity) 

Software Version 
(printed on disk label) 

   
3-31.  Workstation Software. 

Note:  Each DVRS workstation (Recorder, IRR, 
Reproducer, and Remote) must have a set of 
software. 

  

a.  Computer Operating System .........................  Microsoft® MS-DOS™
(3 disks) 

6.22 

b.  Graphical Operating System .........................  Microsoft® Windows™ 
(6 disks) 

3.10 or 3.11 

c.  Workstation Communication Package...........  OnNet 
(4 disks) 

2.11 (Not shown on disk 
label) 

d.  Workstation Installation Package ..................  NiceLog (2 disks) 5.12 

e.  Workstation Network Driver Disk...................  

Note:  There are different versions of the 
Workstation Network Driver Disk.  The original disk 
is labeled Workstation Communication Package 
3COM Diskette 1/1.  Replaced workstations should 
include the appropriate network driver disk.  For 
more information, refer to TI 6670.11A. 

(1 disk) N/A 

f.  Workstation Configuration Backup Disk .........  

Note:  This disk is made locally.  Refer to 
paragraph 5-27 for procedures on creating the 
workstation configuration backup disks. 

(1 disk) N/A 

3-32.  Logger Software. 

Note:  Each DVRS logger (Recorder and 
Reproducer) must have a set of software. 

  

a.  Computer Operating System .........................  Microsoft® MS-DOS™
(3 disks) 

6.22 

b.  Quarterdeck Expanded Memory Manager ....  QEMM™ 
(1 disk) 
or 
(2 disks) 

 
7.0 
or 
7.5 

c.  Logger Communication Package ..................  PCTCP 
(1 disk) 

No visible version 
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Section 2.  Equipment Software Versions (Continued) 
 

Software Platform Software Item/Title 
(Quantity) 

Software Version 
(printed on disk label) 

   
d.  Logger Installation Package ..........................  

 (1)  Dash 4/5 chassis or 
 (2)  Dash 6 chassis 

Note:  The disk label should include the number of 
input channels (i.e. 16, 32, or 48 for recorder 
loggers, and 8 for reproducer loggers). 

NiceLog 

(1 disk) 
(1 disk) 

 
5.12 
5.12 (AHA-1520) 

e.  Logger Configuration Backup Disk ................  

Note:  This disk is made locally.  Refer to 
paragraph 5-28 for procedures on creating the 
logger configuration backup disks. 

(1 disk) N/A 

3-33.  Common to All Loggers.   

 Spare Disk Configuration Utility..........................  SDCU 
(1 disk) 

1.4 

3-34.  Optional Software.   

a.  Anti-Virus Software ........................................  (7 disks) 1.0 

b.  PowerChute Software....................................  PowerChute PLUS 
(1 disk) 
and Logger Shutdown 
(2 disks) 

N/A 
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Chapter 4.  Periodic Maintenance 
 
4-1.  General.  This chapter establishes all maintenance activities that are required for the Digital 
Voice Recorder System (DVRS) on a periodic, recurring basis and the schedules for their 
accomplishment.  The chapter is divided into two sections.  The first section identifies 
performance checks and maintenance tasks that are required to be performed periodically.  The 
performance checks of normal operating controls and functions are necessary to determine 
whether operation is within established tolerances/limits.  The maintenance tasks are necessary 
to prevent deterioration and/or ensure reliable operation.  The second section identifies special 
maintenance tasks that are of a non-periodic nature and to be performed on an as-required basis.  
Refer to Order 6000.15, General Maintenance Handbook for National Airspace System (NAS) 
Facilities, for additional general guidance. 

4-2.  – 4-10.  Reserved. 

Section 1.  Performance Checks and Maintenance Tasks 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
4-11.  At Every Tape Change.   

Recorder/IRR System   

a.  Check the NiceLog Supervision application for indications of alarm 
conditions.1......................................................................................................  

N/A 5-3 

b.  Verify that all input channels on all recorder loggers are recording 
and unlocked...................................................................................................  

N/A 5-4 

4-12.  Weekly.   

Recorder/IRR System   

a.  Verify normal operation of the GPS receiver.......................................  N/A 5-5a 

b.  Verify normal operation of the UPS (for facilities using a single APC 
Smart-UPS 1000 VA, 1400 VA, or 1500 VA) ..................................................  

N/A 5-5b 

c.  Verify the remote alarm is not muted ..................................................  N/A 5-5c 

d.  Clean the DAT drive of each recorder logger......................................  N/A 19 

4-13.  Biweekly.   

Recorder/IRR System   

a.  Verify time correctness of the GPS receiver .......................................  3-11a 5-6a 

b.  Verify time correctness of the recorder/IRR workstation.....................  3-11b 5-6b 

c.  Verify time correctness of the recorder logger ....................................  3-11c 5-6c 

   
 
                                                      
1  These checks may be performed by either Air Traffic (AT) or Technical Operations personnel, 
depending on local agreements and who has responsibility for changing DAT cartridges.  Refer to the 
latest edition of Order 7210.3, Facility Operation and Administration, for more information. 
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Section 1.  Performance Checks and Maintenance Tasks (Continued) 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
Reproducer System   

d.  Clean the DAT drive of the reproducer logger ..................................... N/A 5-19 

4-14.  Monthly.   

Recorder/IRR System   

a.  Verify recorder playback voice quality on all input channels for all 
recorder loggers...............................................................................................

3-12a 5-8 

Note:  To reduce the impact to the operation at large facilities, the 
recorder playback voice quality check can be split (one logger at a time) 
as long as each and every input channels are checked monthly. 

  

b.  Clean all recorder logger air filters ....................................................... N/A 5-20 

Reproducer System   

c.  Clean all reproducer logger air filters ................................................... N/A 5-20 

4-15.  Quarterly.   

Recorder/IRR System   

a.  Verify mandated software settings for recorder/IRR workstation......... 3-13a 5-10 

b.  Verify mandated software settings for all recorder loggers.................. 3-13b 5-11 

c.  Reset passwords for all users on the recorder/IRR workstation.......... N/A 5-14 and 5-15

d.  Verify proper operation of the remote alarm ........................................ 3-14 5-16 

e.  Verify normal operation of the recorder/IRR workstation fan............... N/A 5-17 

Reproducer System   

f.  Verify time correctness of the reproducer workstation.......................... 3-11d 5-7a 

g.  Verify time correctness of the reproducer logger................................. 3-11e 5-7b 

h.  Verify reproducer playback voice quality ............................................. 3-12b 5-9 

i.  Verify mandated software settings for reproducer workstation............. 3-13c 5-12 

j.  Verify mandated software settings for reproducer logger ..................... 3-13d 5-13 

k.  Reset passwords for all users on the reproducer workstation ............. N/A 5-14 and 5-15

l.  Verify normal operation of the reproducer workstation fan ................... N/A 5-17 

Remote Workstation   

m.  Verify time correctness of the remote workstation.............................. 3-11d 5-7a 

n.  Verify mandated software settings for remote workstation .................. 3-13c 5-12 

o.  Reset passwords for all users on the remote workstation ................... N/A 5-14 and 5-15

p.  Verify normal operation of the remote workstation fan(s) .................... N/A 5-17 
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Section 1.  Performance Checks and Maintenance Tasks (Continued) 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
4-16.  Semiannually.   

a.  Check the operation and battery condition of the UPS........................ 3-15 5-18 

b.  Clean cassette audio heads, pinch rollers, and capstan shafts........... N/A 5-21 

4-17.  – 4-20.  Reserved.   
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Section 2.  As-Required Performance Checks and Maintenance Tasks 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
4-21.  Prior to Commissioning.   

a.  Verify software versions installed on all workstation(s) (recorder, 
IRR, reproducer, and remote) .........................................................................  

3-31 5-25 

b.  Verify software versions installed on all logger(s) (recorder and 
reproducer)......................................................................................................  

3-32 5-26 

c.  Create configuration backup disks for all workstation(s) (recorder, 
IRR, reproducer, and remote) .........................................................................  

N/A 5-27 

d.  Create configuration backup disks for all logger(s) (recorder and 
reproducer)......................................................................................................  

N/A 5-28 

e.  Inventory all software and configuration backup disks for all 
workstation(s) (recorder, IRR, reproducer, and remote) and all loggers(s) 
(recorder and reproducer) ...............................................................................  

N/A 5-36 

f.  Complete logger information record sheet for all loggers (recorder 
and reproducer)...............................................................................................  

N/A 5-37 

g.  Complete workstation information record sheet for all workstation(s) 
(recorder, IRR, reproducer, and remote) ........................................................  

N/A 5-38 

Recorder/IRR System   

h.  Verify normal operation of the recorder/IRR equipment .....................  N/A 5-5 

i.  Verify time correctness of the recorder/IRR equipment .......................  3-11a thru c 5-6 

j.  Verify recorder playback voice quality on all input channels for 
recorder loggers ..............................................................................................  

3-12a 5-8 

k.  Verify mandated software settings for recorder/IRR workstation ........  3-13a 5-10 

l.  Verify mandated software settings for all recorder logger(s)................  313b 5-11 

m.  Verify proper operation of the remote alarm ......................................  3-14 5-16 

n.  Verify 600 Ohm termination resistor on each audio input channel .....  N/A 5-22 

o.  Verify that all the bridge clips on terminal blocks are in place ............  N/A 5-23 

p.  Verify GPS receiver settings ...............................................................  3-16 5-29 

q.  Verify the GPS time code format and signal levels.............................  3-17 5-30 

r.  Verify recorder logger performance characteristics .............................  3-18 5-31 

s.  Create a reference DAT cartridge for future maintenance use ...........  N/A Appendix B 

IRR/Reproducer System   

t.  Verify cassette player/recorde channel assignments...........................  3-20 N/A 

u.  Calibrate cassette player/recorder ......................................................  3-21 5-34 

v.  Verify cassette player/recorder performance ....................................... 3-22 5-35 
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Section 2.  As-Required Performance Checks and Maintenance Tasks (Continued) 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
Reproducer/Remote System   

w.  Verify time correctness of the reproducer/remote equipment ............. 3-11d thru e 5-7 

x.  Verify mandated software settings for the reproducer/remote 
workstation(s)...................................................................................................

3-13c 5-12 

Reproducer System   

y.  Verify reproducer playback voice quality.............................................. 3-12b 5-9 

z.  Verify mandated software settings for reproducer logger .................... 3-13d 5-13 

aa.  Verify reproducer logger performance characteristics ....................... 3-19 5-32 

4-22.  After Recorder/IRR Workstation Replacement or Software 
Reload. 

  

a.  Verify time correctness of the recorder workstation............................. 3-11b 5-6b 

b.  Verify mandated software settings for the recorder/IRR workstation... 3-13a 5-10 

c.  Verify proper operation of the remote alarm ........................................ 3-14 5-16 

d.  Verify software versions installed on the recorder/IRR workstation..... 3-31 5-25 

e.  Inventory all software and configuration backup disks for the 
recorder/IRR workstation .................................................................................

N/A 5-36 

f.  Update workstation information record sheet for the recorder/IRR 
workstation, if configuration changes...............................................................

N/A 5-38 

4-23.  After Reproducer/Remote Workstation Replacement or Software 
Reload. 

  

a.  Verify time correctness of the reproducer/remote workstation............. 3-11d 5-7a 

b.  Verify mandated software settings for the reproducer/remote 
workstation.......................................................................................................

3-13c 5-12 

c.  Verify software versions installed on the reproducer/remote 
workstation.......................................................................................................

3-31 5-25 

d.  Inventory all software and configuration backup disks for the 
reproducer/remote workstation ........................................................................

N/A 5-36 

e.  Update workstation information record sheet for the 
reproducer/remote workstation, if configuration changes................................

N/A 5-38 

4-24.  After Recorder Logger Hard Drive Replacement or Software 
Reload. 

  

a.  Verify time correctness of the recorder logger ..................................... 3-11c 5-6c 

b.  Verify mandated software settings for the recorder logger .................. 3-13b 5-11 

c.  Verify software version installed on the recorder logger. ..................... 3-32 5-26 
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Section 2.  As-Required Performance Checks and Maintenance Tasks (Continued) 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
d.  Inventory all software and configuration backup disks for the 

recorder logger................................................................................................  
N/A 5-36 

e.  Update logger information record sheet for the recorder logger, if 
configuration changes .....................................................................................  

N/A 5-37 

4-25.  After Reproducer Logger Hard Drive Replacement or Software 
Reload. 

  

a.  Verify time correctness of the reproducer logger ................................  3-11e 5-7b 

b.  Verify mandated software settings for the reproducer logger .............  3-13d 5-13 

c.  Verify software version installed on the reproducer logger .................  3-32 5-26 

d.  Inventory all software and configuration backup disks for the 
reproducer logger............................................................................................  

N/A 5-36 

e.  Update logger information record sheet for the reproducer logger, if 
configuration changes .....................................................................................  

N/A 5-37 

4-26.  At Any Time the Logger Cover is Opened.   

 Verify normal operation of logger cooling fans .........................................  N/A 5-33 

4-27.  After an Audio Board Replacement in a Recorder Logger.   

a.  Verify recorder playback voice quality on all input channels for the 
recorder logger................................................................................................  

3-12a 5-8 

b.  Verify recorder logger performance characteristics ............................  3-18 5-31 

c.  Update logger information record sheet for the recorder logger, if 
configuration changes .....................................................................................  

N/A 5-37 

4-28.  After an Audio Board Replacement in a Reproducer Logger.   

a.  Verify reproducer logger performance characteristics ........................  3-19 5-32 

b.  Verify reproducer playback voice quality.............................................  3-12b 5-9 

c.  Update logger information record sheet for the reproducer logger, if 
configuration changes .....................................................................................  

N/A 5-37 

4-29.  After Upgrading the Input Channel Capacity.   

a.  Verify time correctness of the recorder logger. ...................................  3-11c 5-6c 

b.  Verify recorder playback voice quality for new input channels ...........  3-12a 5-8 

c.  Verify mandated software settings for the recorder/IRR workstation.. 3-13a 5-10 

d.  Verify mandated software settings for the recorder logger .................  3-13b 5-11 

e.  Verify 600 Ohm termination resistor on each audio input channel......  N/A 5-22 

f.  Verify that all the bridge clips on terminal blocks are in place. ............  N/A 5-23 

g.  Update configuration backup disk for the recorder workstation ..........  N/A 5-27 
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Section 2.  As-Required Performance Checks and Maintenance Tasks (Continued) 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
h.  Update configuration backup disk for the recorder logger ..................  N/A 5-28 

i.  Verify recorder logger performance characteristics for new input 
channels ..........................................................................................................  

3-18 5-31 

j.  Inventory all software and backup disks for the recorder logger..........  N/A 5-36 

k.  Update logger information sheet for the recorder logger ....................  N/A 5-37 

4-30.  At Daylight Savings Time Transition.  (for facilities using the 
scheduled recording feature) 

  

a.  Change scheduled recording settings .................................................  N/A 5-10c 

b.  Update configuration backup disk for the recorder workstation ..........  N/A 5-27 

c.  Update workstation information record sheet for the recorder 
workstation ......................................................................................................  

N/A 5-38 

4-31.  After Any Change in Workstation Software Settings.  (loggers, 
user IDs/passwords, scheduled recording, etc.) 

  

a.  Update configuration backup disk for the target workstation ..............  N/A 5-27 

b.  Update workstation information record sheet for the target workstation N/A 5-38 

4-32.  After Any Change in Logger Software Settings.  (input/output 
channel name, scheduled ejecting DAT, etc.) 

  

a.  Update configuration backup disk for the target logger.......................  N/A 5-28 

b.  Update logger information record sheet for the target logger. ............  N/A 5-37 

4-33.  Before Making Certified Re-Recording Cassette Copy.   

Calibrate cassette player/recorder with the logger where the source 
recording(s) is located.....................................................................................  

3-21 5-34 

4-34.  After GPS Receiver Replacement.   

a.  Verify time correctness of the GPS receiver .......................................  3-11a 5-6a 

b.  Verify GPS receiver settings ...........................................................  3-16 5-29 

c.  Verify GPS time code format and signal levels ...................................  3-17 5-30 

4-35.  After Loss of AC Power to UPS but Before Battery is Completely 
Drained. 

  

Note:  The maintenance tasks below will cause a recording service 
outage, only complete them if the UPS is on battery and a total loss of 
power to the DVRS rack is imminent. 

  

a.  Perform software shutdown and then power off all recorder loggers..  N/A N/A 

b.  Perform software shutdown of the recorder workstation.....................  N/A N/A 
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Section 2.  As-Required Performance Checks and Maintenance Tasks (Continued) 
 

Reference Paragraph 
Performance Checks and Maintenance Tasks Standards & 

Tolerances 
Maintenance 
Procedures 

   
4-36.  After Restoration of AC Power to UPS.   

Note:  Do steps 4-36a and b only if the DVRS is already powered down.   

a.  Perform manual power up of all recorder loggers ...............................  N/A N/A 

b.  Perform manual power up of recorder/IRR workstation......................  N/A N/A 

c.  Check the NiceLog Supervision application for indications of alarm 
conditions ........................................................................................................  

N/A 5-3 

d.  Verify that all input channels on all recorder loggers are recording and 
unlocked..........................................................................................................  

N/A 5-4 

e.  Verify normal operation of the recorder/IRR equipment .....................  N/A 5-5 

f.  Verify time correctness of the recorder/IRR equipment .......................  3-11a thru c 5-6 

g.  Insert DAT cartridge for automatic archiving.......................................  N/A N/A 
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Chapter 5.  Maintenance Procedures 

5-1.  General.  This chapter provides the procedures for accomplishing various essential 
maintenance activities that are required for the Digital Voice Recording System (DVRS) 
equipment.  This chapter is divided into two sections.  The first section contains the procedures 
for performing the periodic tasks listed in chapter 4, section 1.  The second section describes the 
procedures for non-periodic tasks, which are to be performed on an as-required basis, listed in 
chapter 4, section 2.  Refer to Order 6000.15, General Maintenance Handbook for National 
Airspace System (NAS) Facilities, for additional general maintenance guidance. 

5-2.  FAA Form 6000 Series Entries.  Order 6000.15 contains policy, guidance and detailed 
instructions for field utilization of FAA Form 6000 series, Technical Performance Record (TPR).  
Entries must be made in accordance with instructions published in the latest version of Order 
6000.15.  A sample of DVRS TPR Form 6670-3 (12/08) is included at the end of this chapter.  
This form is available online at the FAA electronic document systems (FEDS) web page, 
http://feds.faa.gov. 

 

Section 1.  Performance Check and Maintenance Task Procedures 

5-3.  Check the NiceLog Supervision Application for Indications of Alarm Condition. 

a.  At the recorder/IRR workstation, maximize the NiceLog Supervision window.  See figure 
5-1. 

Figure 5-1.  NiceLog Supervision Window 

 

b.  Verify there are no alarm indications for each of the recorder loggers.  Verify the Status 
column of all recorder loggers shows “Test OK” and “Automatic Archiving.” 
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c.  Verify that all loggers have alarm enabled (no “X” in the Alarm column).  The Alarm icon 
on the toolbar is used to toggle between disable and enable alarm. 

d.  Minimize the NiceLog Supervision application window. 

Note:  Never exit the NiceLog Supervision application during normal operation of the 
recorder/IRR workstation.  The Supervision application must be operating at all times on the 
recorder/IRR workstation.  If the Supervision program is not operating, the external alarm will 
not function.  NiceLog Supervision is still operating when minimized. 

5-4.  Verify that All Input Channels are Recording and Unlocked. 

a.  At the recorder/IRR workstation, login to the NiceLog Voice Logger application and 
connect to the target logger. 

b.  In the View pull-down menu, select Inputs.  Refer to figure 5-2 for the Inputs view. 

Figure 5-2.  Inputs View 

 

c.  Verify all input channels are in the record mode of operation.  In the Record column, the 
blue recording reel icon indicates the channel is actively recording. 

Note:  A gray recorder reel icon indicates the system is set for scheduled recording and 
recording is currently suspended.  If a gray recording reel icon is displayed at the time 
recording should be unsuspended, it may be necessary to correct the scheduled recording setup.  
After correcting the scheduled recording setup, perform a manual stop/start recordings for the 
change to take effect. 
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d.  In the View pull-down menu, select Recordings.  Then in the View pull-down menu, select 
Filter.  In the Filter Recordings window, select Locked.  Click OK.  The list will be filtered and 
will display only the locked recordings.  Recordings/channels that are locked have an “L” in the 
Flags column of the Recordings screen.  See figure 5-3. 

Figure 5-3.  Recordings – Locked Filter 

 

e.  Verify that none of the locked recordings/channels displays “Recording” in the Stop Time 
column. 

Note:  Locking an actively recording channel will fill the hard drive.  When the hard drive is 
full, the system will stop recording. 

f.  In the View pull-down menu, select Filter.  In the Filter Recordings window, select All.  
Click OK. 

g.  Repeat this procedure for each recorder logger. 

5-5.  Verify Normal Operation of Recorder/IRR Equipment. 

a.  Global Positioning System (GPS) receiver.  Observe and verify that the Status Light 
Emitting Diode (LED) on the GPS receiver is blinking green. 

b.  Uninterruptible Power Supply (UPS) (for facilities using a single APC Smart-UPS 
1000 VA, 1400 VA, or 1500 VA). 

(1)  Verify the UPS Monitor application is operating and minimized on the desktop 
screen as shown in figure 5-4.  If the icon is not displayed, perform the following steps to restart 
the program; otherwise, proceed to step (2). 
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Figure 5-4.  UPS Monitor Icon 

 

(a)  Double-click on the Program Manager icon on the Windows desktop.  The 
Program Manager window opens, as shown in figure 5-5. 

Figure 5-5.  Program Manager Window 

 

(b)  Double-click on the PowerChute Plus: Windows icon.  The PowerChute Plus: 
Windows window opens, as shown in figure 5-6. 

Figure 5-6.  PowerChute PLUS: Windows 

 

(c)  First launch the PowerChute PLUS Server by double-clicking on the UPS 
Monitor icon.  The PowerChute Plus Server window opens as shown in figure 5-7. 
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Figure 5-7.  PowerChute Plus Server 

 

(d)  Next launch the UPS Monitor program by double-clicking on the PowerChute 
PLUS icon from the PowerChute Plus: Windows window.  The PowerChute PLUS window 
opens as shown in figure 5-8. 

Note:  Never exit the UPS Monitor program during normal operation of the recorder/IRR 
workstation.  The program must be operating at all times to monitor the status and condition of 
the UPS.  If the UPS Monitor program is not operating, the remote alarm will not function in 
case of power and/or UPS failure that may cause improperly shutdown of the logger(s) and 
result in software database corruption.  The UPS Monitor will still be operating when 
minimized. 

Figure 5-8.  PowerChute PLUS Main Screen 

 

(2)  Verify the UPS Temp is in the range +32°F to +104°F (0°C to +40°C).  Verify that 
the black Utility and UPS Load bars display in the green area of the bar graph. 

(3)  Select Monitoring Preferences from the Configuration pull-down menu.  In the 
Monitoring Preferences window, select Battery Capacity from the Bar Graph Type dropdown 
list as shown in figure 5-9.  Click OK to close the Monitoring Preferences window. 



12/03/2008 JO 6670.13A 
 

5-6 

Figure 5-9.  Monitoring Preferences 

 

(4)  In the PowerChute PLUS main screen, the left-most bar graph displays the battery 
capacity.  Verify that the battery capacity is 100%. 

(5)  Select Monitoring Preferences from the Configuration pull-down menu.  In the 
Monitoring Preferences window, select Run Time Remaining from the Bar Graph Type drop-
down list as shown in figure 5-10.  Click OK to close the Monitoring Preferences window. 

Figure 5-10.  Monitoring Preferences 

 

(6)  The left-most and the right-most graphs on the PowerChute PLUS main screen will 
display Run Time Remaining and UPS Load, respectively.  Plot the Run Time versus UPS Load 
in the Rated Battery Capacity graph corresponding to the UPS model, shown in figure 5-11, 
figure 5-12, and figure 5-13.  If the data point falls below the curve in the “Bad Area” of the 
graph, the UPS battery is failing and needs to be replaced. 
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Figure 5-11.  Rated Battery Capacity for Smart-UPS 1000 VA 

0

10

20

30

40

50

20% 30% 40% 50% 60% 70% 80% 90% 100%

Load (percentage) on PowerChute Plus Screen

M
in

im
um

 R
un

 T
im

e 
(m

in
ut

es
) o

n 
Po

w
er

C
hu

te
 P

lu
s 

Sc
re

en
Smart-UPS 1000 (3 ½ " Rack Space)

Smart-UPS 1000 (5 ¼" Rack Space)

Bad Area

Good Area

 

Figure 5-12.  Rated Battery Capacity for Smart-UPS 1400 VA 

0

10

20

30

40

50

20% 30% 40% 50% 60% 70% 80% 90% 100%

Load (percentage) on PowerChute Plus Screen

M
in

im
um

 R
un

 T
im

e 
(m

in
ut

es
) o

n 
Po

w
er

C
hu

te
 P

lu
s 

Sc
re

en

Smart-UPS 1400 (3 ½ " Rack Space)

Smart-UPS 1400 (5 ¼" Rack Space)

Good Area

Bad Area

14

34.3
 



12/03/2008 JO 6670.13A 
 

5-8 

Figure 5-13.  Rated Battery Capacity for Smart-UPS 1500 VA 
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Note:  The UPS battery capacity must be 100.0% before proceeding with the Self Test. 

(7)  From the Diagnostics pull-down menu in the PowerChute PLUS main screen, select 
Initiate UPS Self Test. 

(8)  The UPS will switch from on-line operation to battery operation briefly.  The front 
panel LED will briefly light and the UPS will emit a beep.  On the main screen, the Status field 
changes to “Self Test” for a few seconds and then resumes to “On Line.”  When it completes, the 
Last UPS Self Test field will display the result of the self-test.  Possible results are: 

(a)  Passed:  Self Test passed. 

(b)  Failed:  The UPS failed the self-test.  Charge the battery for eight hours, and 
perform the self-test again.  If the UPS fails the test again, replace the battery. 

(c)  Invalid Test:  The UPS is in a state that is preventing a valid self-test from being 
performed.  Wait for one hour and perform the self-test again.  If the result is Invalid Test again, 
replace the UPS. 

c.  Verify the remote alarm is not muted.  Verify the position of the switch on the remote 
alarm unit to ensure that it is not in the muted position. 
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5-6.  Verify Time Correctness of the Recorder/IRR Equipment. 

a.  GPS receiver.  Verify the date/time displayed on the GPS receiver is synchronized with 
the Universal Time Coordinated (UTC) by calling the National Institute of Standards and 
Technology Time and Frequency shortwave radio station (WWV) at (303) 499-7111. 

b.  Recorder/IRR workstation. 

(1)  In the Main window, double-click on the Control Panel icon.  In the Control Panel 
window, double-click on the International icon.  The International application window opens as 
shown in figure 5-14.  In the Time Format section, click Change, and ensure the Time Format is 
set for 24-hour Zulu with Leading Zero display.  Press OK to close International application 
windows. 

Figure 5-14.  Configuring Recorder/IRR Workstation Time 

 

(2)  In the Control Panel window, double-click on the Date/Time icon.  The Date & Time 
window opens as shown in figure 5-15.  Verify that the workstation date and time are 
synchronized with the date and time displayed on the GPS receiver.  If necessary, adjust the date 
and time.  Press OK to close the Date & Time window. 

Figure 5-15.  Workstation Date & Time Window 
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c.  Recorder logger(s). 

(1)  At the recorder/IRR workstation, login to the NiceLog Voice Logger application 
using the sysadm user ID, and connect to the target logger. 

(2)  From the Maintenance pull down menu, select Configure clock.  The Clock 
Configuration window appears as shown in figure 5-16.  Verify that Use external clock is 
selected.  Click OK to close the Clock Configuration window. 

Figure 5-16.  Clock Configuration Window 

 

(3)  In the upper right hand corner of the NiceLog Voice Logger window, shown in figure 
5-17, verify that the displayed date and time are synchronized with the GPS receiver. 

Figure 5-17.  Recorder Logger Time 

 

(4)  Repeat this procedure for each recorder logger. 

5-7.  Verify Time Correctness of the Reproducer/Remote Equipment. 

a.  Reproducer/remote workstation. 

(1)  At the reproducer/remote workstation, double-click on the Control Panel icon in the 
Main window.  In the Control Panel window, double-click on the International icon.  The 
International application window opens as shown in figure 5-18.  In the Time Format section, 
click Change, and ensure the Time Format is set for 24-hour Zulu with Leading Zero display.  
Press OK to close International application windows. 
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Figure 5-18.  Configuring Reproducer/Remote Workstation Time 

 

(2)  In the Control Panel window, double-click on the Date/Time icon.  The Date & Time 
window opens as shown in figure 5-19.  Verify that the workstation date and time are 
synchronized with UTC by calling the WWV station at (303) 499-7111.  If necessary, adjust the 
date and time.  Press OK to close the Date & Time window. 

Figure 5-19.  Workstation Date & Time Window 

 

b.  Reproducer logger. 

(1)  At the reproducer workstation, login to the NiceLog Voice Logger application using 
the sysadm user ID, and connect to the reproducer logger. 

(2)  From the Maintenance pull down menu, select Configure clock.  The Clock 
Configuration window appears as shown in figure 5-20.  Verify that Use internal clock is 
selected.  Click OK to close the Clock Configuration window. 
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Figure 5-20.  Clock Configuration Window 

 

(3)  In the upper right hand corner of the NiceLog Voice Logger window, shown in figure 
5-21, verify that the displayed date and time are synchronized with UTC by calling the WWV 
station at (303) 499-7111.  If necessary, perform the following steps to adjust the time. 

Figure 5-21.  Reproducer Logger Time 

 

(a)  Select Set logger clock from the Maintenance pull-down menu. 

(b)  In the Setup Logger Clock window, shown in figure 5-22, enter the correct UTC 
date and time.  Depending on whether Julian or Gregorian date is selected in the View menu of 
NiceLog Voice Logger, the Setup Logger Clock window will appear as one of the two windows 
shown in figure 5-22. 

Figure 5-22.  Setup Logger Clock 
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5-8.  Verify Recorder Playback Voice Quality. 

Note:  The recorder playback voice quality is evaluated by aurally monitoring the recording of 
all voice frequency recorder channels.  To ensure that the entire record path is being evaluated, 
actual air traffic (AT) conversations recorded within the last two hours must be used to 
determine the quality of voice playback.  Arrange for a test count on channels that do not 
contain AT voice within the last two hours.  The duration between the first and last AT 
conversation and/or test count must not exceed two hours.  After the test counts have been 
completed, wait for them to be archived to DAT.  Under normal circumstances the audio is 
archived to DAT within one hour from the time of the last test count. 

Note:  To reduce the impact to the operation at large facilities, the recorder playback voice 
quality check can be split (one logger at a time) as long as each and every input channel is 
checked monthly. 

a.  At the recorder/IRR workstation, use the sysadm user ID to open the NiceLog Voice 
Logger application and connect to the target logger. 

b.  In the upper right hand corner of the NiceLog Voice Logger window, select the Recorder 
output channel. 

c.  In the Playback pull-down menu, select Setup output.  The Setup Output window appears.  
Verify that the Volume Control slider is set to the maximum position and the Automatic Gain 
Control (AGC) option is disabled.  Click OK. 

d.  Retrieve the AT conversations and/or test counts from the online DAT cartridge as 
follows: 

(1)  Click the Decks icon on the toolbar.  In the Decks window, click the deck button 
(Deck 1 or Deck 2) used for retrieval.  The DAT Contents window appears.  Verify that the DAT 
cartridge contains the time of the desired audio. 

(2)  In the DAT Contents window, highlight all channels and then click the Start 
Retrieval button. 

(3)  The Retrieval From DAT To Disk window appears.  Select From and enter the start 
time of the first test count and/or AT conversation.  Select To and enter the time of the last test 
count and/or AT conversation.  Click the Retrieve button.  See figure 5-23. 
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Figure 5-23.  Retrieval From DAT To Disk 

 

(4)  Click Close to close the DAT Contents window.  In the Decks window, the Operation 
will change from “Automatic Archiving” to “Retrieval” and the Status will change from 
“Archiving” to “Retrieving.”  When the Status changes back to “Archiving,” retrieval is 
complete.  Click Close to close the Decks window. 

e.  In the View pull-down menu, select Recordings.  In the View pull-down menu, select 
Filter.  In the Filter Recordings window, select Last retrieved.  Click OK to close the Filter 
Recordings window. 

f.  The screen displays all of the recordings that were last retrieved.  Verify that at least one 
recording exists for each channel. 

g.  Highlight a recording on one channel, and click the Play icon on the toolbar.  The Skip 
Silence option in the Playback window may be used to assist in locating test counts and/or AT 
conversation.  Aurally monitor the test count or voice conversation to determine the quality of 
voice playback.  This check should be made using considerable care to ascertain that good 
quality recordings are being provided.  Poor quality may take the form of distortion, hum, high 
noise level, crosstalk, and/or weak recording.  Repeat this step for all channels. 

h.  Ensure that only the last retrieved recordings are displayed on the screen (the line under 
the toolbar must read “Recordings – Last Retrieved”).  Highlight all recordings and select Delete 
recordings in the Playback pull down menu.  When prompted for confirmation, click Yes to All. 

i.  In the View pull-down menu, select Filter.  In the Filter Recordings window, select All.  
Click OK to close the Filter Recordings window.  In the View pull-down menu, select Inputs. 

Note:  Playback Voice Quality for the recorder logger is recorded as a pass or fail condition on 
the Technical Performance Record (TPR) for all channels.  If all channels meet the standards 
and tolerances, enter a pass (√) in the appropriate column in the TPR form; if any channel does 
not meet the standards and tolerances, enter a fail (X) in the appropriate column in the TPR 
form. 

5-9.  Verify Reproducer Playback Voice Quality. 

Note:  This procedure requires a pre-recorded DAT cartridge that contains live audio from 
within the last 48 hours.  Obtain the DAT cartridge prior to proceeding with the verification. 
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a.  At the reproducer workstation, login to the NiceLog Voice Logger application using the 
sysadm user ID and connect to the reproducer logger. 

b.  In the upper right hand corner of the NiceLog Voice Logger window, select the 
Reproducer output channel. 

c.  In the Playback pull-down menu, select Setup output.  The Setup Output window appears.  
Verify that the Volume Control slider is set to the maximum position and the AGC option is 
disabled. 

d.  Retrieve the recordings from the pre-recorded DAT cartridge as follows: 

(1)  From the Archive pull down menu, select Retrieval.  The software will prompt for 
inserting a DAT.  Insert the DAT cartridge into the DAT drive for retrieval, and press OK. 

(2)  The Decks dialog box appears.  Wait for the cartridge to finish loading and the Status 
to change to “Ready,” and then click the Deck 1 button. 

(3)  The DAT Contents window appears, as shown in figure 5-24.  Select several 
channels that contain audio for verification.  Press the <Ctrl> key for multiple selections, and 
then click the Start Retrieval button. 

Figure 5-24.  Retrieval of DAT Contents 

 

(4)  The Retrieval From DAT To Disk window appears.  Select From and enter the start 
time of the desired audio.  Select To and enter the end time of the desired audio.  Click the 
Retrieve button.  See figure 5-25. 
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Figure 5-25.  Retrieval From DAT To Disk 

 

(5)  Click Close to close the DAT Contents window.  In the Decks window, the Status 
will change from “Ready” to “Retrieving.”  When the Status changes back to “Ready,” retrieval 
is complete.  Click Close to close the Decks window. 

e.  Click the Deck 1 button.  In the DAT Contents window, click Quit Retrieval.  Click OK at 
the prompt “Ejecting DAT from deck 1,” and then wait for the DAT cartridge to be ejected.  
Click Close to close the Decks window and remove the DAT cartridge. 

f.  In the View pull-down menu, select Recordings.  In the View pull-down menu, select 
Filter.  In the Filter Recordings window, select Last retrieved.  Click OK to close the Filter 
Recordings window. 

g.  The screen displays all of the recordings that were last retrieved.  Verify the last retrieved 
recordings are listed. 

h.  Insert a cassette tape into deck 2 (or B) of the dual cassette deck.  Place the dual cassette 
deck in pause-record mode. 

i.  Highlight a recording and click the Play icon on the toolbar.  The Skip Silence option in 
the Playback window may be used to assist in locating desired audio.  Aurally monitor the test 
count or voice conversation to determine the quality of voice playback.  This check should be 
made using considerable care to ascertain that good quality recordings are being provided.  Poor 
quality may take the form of distortion, hum, high noise level, crosstalk, and/or weak recording.  
Repeat this step on several recordings.  It is unnecessary to check the reproducer playback voice 
quality on every channel. 

j.  Ensure that only the last retrieved recordings are displayed on the screen (the line under 
the toolbar must read “Recordings – Last Retrieved”).  Highlight all recordings and select Delete 
recording in the Playback pull down menu.  When prompted for confirmation, click Yes to All. 

k.  In the View pull-down menu, select Filter.  In the Filter Recordings window, select All.  
Click OK to close the Filter Recordings window. 
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5-10.  Verify Mandated Software Settings for Recorder/IRR Workstation. 

Note:  The software parameters not mentioned in this section either must not be used, are not 
available, or there are no mandated settings for that particular software parameter. 

Note:  In order to access all software parameters for verification, the sysadm user ID must be 
used to open the NiceLog Supervision application.  The application might have already been 
started by another user; exit and restart the application using the sysadm user ID. 

a.  At the recorder workstation, login to the NiceLog Supervision application using the 
sysadm user ID. 

b.  Click the Options icon on the toolbar.  The Supervision Options window appears.  All 
options must be set exactly as shown in figure 5-26.  Click OK to close the Supervision Options 
window. 

Figure 5-26.  NiceLog Supervision Options 

 

c.  In the Maintenance pull-down menu, select Scheduled Recording.  The Scheduled 
Recording window appears.  For facilities that are operational 24 hours a day, scheduled 
recording must not be used.  The Enable Scheduled Recording box must be unchecked, as shown 
in figure 5-27.  For facilities that are not operational 24 hours per day, scheduled recording may 
be enabled.  The time used to set for the scheduled recording must be UTC; refer to figure 5-28 
for an example.  Click OK to close the Scheduled Recording window. 

Note:  Use of the Scheduled Recording option must require that the settings be changed twice 
each year to compensate for localities that observe daylight saving time. 
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Figure 5-27.  Scheduled Recording Disabled 

 

Figure 5-28.  Scheduled Recording Enabled 

 

d.  If necessary, exit the Supervision application and restart it using the user ID normally 
used for daily operation.  Minimize the application. 

e.  Login to the System Administration application using the sysadm user ID. 

f.  Click on Loggers! at the top of the System Administration window.  All available recorder 
loggers must be listed except for the reproducer logger (if available). 

Note:  If a recorder logger is not listed, it must be added to the loggers list before it can be 
configured/modified.  Refer to TI 6670.11A, volume II for procedures to add a logger in 
NiceLog System Administration. 

g.  Highlight a logger from the list, and click Modify.  The Modify Logger window appears as 
shown in figure 5-29.  Verify the correct Transmission Control Protocol/Internet Protocol 
(TCPIP) address and Logger Name.  Input channels connected to an audio source must be set to 
“Configured;” input channels not connected to an audio source must be set to “Not Configured.”  
All output channels must be set to “Configured.”  Click the Modify button to close the Modify 
Logger window.  Repeat this step for all recorder loggers, and then click Close to close the 
Loggers window. 
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Figure 5-29.  Modify Logger Window 

 

h.  Click on Users! at the top of the System Administration window.  The Users window 
appears.  Verify that only authorized users are listed. 

Note:  If an authorized user is not listed, the user must be added to the users list before it can be 
configured/modified.  Refer to TI 6670.11A, volume II for procedures to add a user in NiceLog 
System Administration. 

i.  Highlight a user and click Modify.  The Modify User window appears as shown in figure 
5-30.  Verify that each user is set in accordance with table 5-1.  Click the Channel Access button 
to verify input/output channels configured for each accessible logger.  Click Modify to close the 
Modify User window.  Repeat this step for all users.  Click Close to close the Users window, and 
then exit the System Administration application. 

Figure 5-30.  Modify User Window 
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Table 5-1.  Recorder Workstation User Settings 

Caution:  User IDs and passwords must be entered in lowercase.  Failure to create user IDs and 
passwords with lowercase can lead to future problems.  Once the user IDs and passwords are created, 
the user can login using upper case, lower case, or mixed case.  
Note:  When the Password Reset box is checked, the password associated with the user being modified 
is reset.  The next time the user logs into any NiceLog application, they must leave the password field 
blank.  They will then be prompted to create a new password. 

System Administrator. 

User ID:  sysadm (not 
configurable).  
Name: System Administrator 
(not configurable). 

The sysadm user is preset by the software and has access to all 
loggers, channels, and functions. 

Reproduce Only (@Rec).  A different user ID and password must be used for each user of this group. 

User ID:  Not configurable; 
user ID is initially set by the 
site when a new user is 
added.  
Name:  Must be Reproduce 
Only (@Rec). 

Loggers:  All recorder loggers must be in the Accessible column.  
Reproducer loggers must be in the Not Accessible column.  
Channel Access:  For each recorder logger, all input and output 
channels must be accessible.  
Type:  Must not be altered.  The program will change Type when 
necessary.  
Functions:  Must be set as follows: 

 

 

Available 
Archive - Operations 
Archive - View Decks 
Configuration - View 
Maintenance - Self Test 
Recordings - Delete 
Recordings - Lock/Unlock 
Recordings - Playback 

Not Available 
Configuration - Modify 
Inputs - Monitor  
Inputs - Record Start/Stop 
Inputs - Setup 
Maintenance - Advanced 
Outputs - Setup 

Monitor Only (@Rec).  A different user ID and password must be used for each user of this group. 

User ID:  Not configurable; 
user ID is initially set by the 
site when a new user is 
added.  
Name:  Must be Monitor Only 
(@Rec). 

Loggers:  All recorder loggers must be in the Accessible column.  
Reproducer loggers must be in the Not Accessible column.  
Channel Access:  For each recorder logger, all input and output 
channels must be accessible.  
Type:  Must not be altered.  The program will change Type when 
necessary.  
Functions:  Must be set as follows: 

 

 

Available 
Archive - View Decks 
Configuration - View 
Inputs - Monitor  
Maintenance - Self Test  
Recordings - Playback 

Not Available 
Archive - Operations 
Configuration - Modify 
Inputs - Record Start/Stop 
Inputs - Setup 
Maintenance - Advanced 
Outputs - Setup 
Recordings - Delete 
Recordings - Lock/Unlock 
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5-11.  Verify Mandated Software Settings for Recorder Logger(s). 

Note:  The software parameters not mentioned in this section either must not be used, are not 
available, or there are no mandated settings for that particular software parameter. 

Note:  In order to access all software parameters for verification, the sysadm user ID must be 
used to open the NiceLog Voice Logger application.  The application might have already been 
started by another user; exit and restart the application using the sysadm user ID. 

a.  At the recorder workstation, login to the NiceLog Voice Logger application using the 
sysadm user ID.  Connect to a recorder logger. 

(1)  Setup Input Channels.  In the View pull-down menu, select Inputs.  The Input 
Channels screen appears as shown in figure 5-31. 

Figure 5-31.  Input Channels Screen 

 

(2)  Double click an input channel.  The Setup Input Channel window appears as shown 
in figure 5-32.  All input channel options must be set as shown in figure 5-32, with the exception 
of the Identification and Activity Statistics.  There are no mandated settings for the Identification 
and Activity Statistics.  Click OK to close the Setup Input Channel window.  Repeat this step for 
all input channels. 

Note:  All parameters except Identification and Activity Statistics must be set exactly the same 
for all input channels.  If the site does not use the activity statistics alarms or if they are set the 
same for all channels, Setup all input channels from the Record pull-down menu can be used to 
quickly verify all channels at one time. 
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Figure 5-32.  Setup Input Channel Window 

 

Note:  The DVRS software is capable of tracking individual channel activity statistics.  This is 
a good feature that can provide an alarm when the recorder detects abnormal activity rates.  For 
instance, 0% activity might indicate an open circuit while 100% activity might indicate a noisy 
line.  The activity statistics alarm is a site option.  If the site uses activity statistics alarms, the 
settings may need to be tailored for each individual channel to minimize unnecessary alarms.  
For example, for a channel that is expected to have 0% activity, it is possible that nuisance 
alarms could be generated if the activity statistics alarm is enabled.  It is recommended that 
activity statistics are initially set as shown in figure 5-32 and then individually customized to 
the observed activity rate for each channel over time.  Refer to TI 6670.11A, volume II for 
more information on activity statistics alarms. 

(3)  Setup Output Channels.  From the Output drop-down box located in the upper right 
hand corner of the NiceLog Voice Logger window, select the first output channel as shown in 
figure 5-33. 

Figure 5-33.  Output Drop-Down Box 

 

(4)  From the Playback drop-down menu, select Setup output.  The Setup Output Channel 
window appears as shown in figure 5-34.  All output channel options must be set as shown in 
figure 5-34, with the exception of the Identification.  There are no mandated settings for the 
Identification.  Click OK to close the Setup Output Channel window.  Repeat this step for the 
second and third output channels. 
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Figure 5-34.  Setup Output Channel Window 

 

Note:  The output identification must adequately describe the output channel purpose and/or 
destination depending on the site configuration.  The following are recommended 
identifications based on major configuration: 

 With Reproducer With IRR 

Output #1: Reproducer or Recorder Recorder 

Output #2: Recorder or Reproducer Remote WS or Not Used 

Output #3: Remote WS or Not Used Not Used 

(5)  Configure Archive Decks.  From the Maintenance pull down menu, select Configure 
archive decks.  Deck 1 and Deck 2 must be enabled as shown in figure 5-35.  Click OK to close 
the Archive Decks window. 

Figure 5-35.  Configure Archive Decks 

 

(6)  Setup Automatic Archiving.  From the Archive pull down menu, select Setup 
Automatic Archiving.  The Automatic Archiving Setup window appears.  The parameters must 
be set as shown in either figure 5-36 or figure 5-37, depending on the facility’s audio retention 
period.  Click OK to close the Automatic Archiving Setup window. 

Note:  The Overwrite parameter must be set to either 46 or 17 days, depending on the facility.  
The 46-day setting protects the DAT cartridge from being overwritten for 45 days.  The 17-day 
setting protects the DAT cartridge from being overwritten for 15 days. 

Note:  The Automatically Eject DAT periodic time must be UTC time and determined by the 
site. 
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Figure 5-36.  45-Day Retention 

 

Figure 5-37.  15-Day Retention 

 

(7)  Configure Clock.  From the Maintenance pull down menu, select Configure clock.  
Use external clock must be enabled as shown in figure 5-38, and then click OK. 

Figure 5-38.  Configure Clock 
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(8)  Configure Automatic Deletion.  From the Maintenance pull-down menu, select 
Configure automatic deletion.  Delete oldest audio must be enabled as shown in figure 5-39, and 
then click OK. 

Figure 5-39.  Configure Automatic Deletion 

 

b.  Repeat steps (1) through (8) for all recorder loggers. 

5-12.  Verify Mandated Software Settings for Reproducer/Remote Workstation. 

Note:  The remote workstation is optional.  The logger and user administration on the remote 
workstation are site-specific. 

Note:  The software parameters not mentioned in this section either must not be used, are not 
available, or there are no mandated settings for that particular software parameter. 

a.  At the reproducer/remote workstation, login to the NiceLog System Administration 
application using the sysadm user ID. 

b.  Click on Loggers! at the top of the System Administration window.  All available 
recorder and reproducer loggers must be listed. 

Note:  If a logger is not listed, it must be added to the loggers list before it can be 
configured/modified.  Refer to TI 6670.11A, volume II for procedures to add a logger in 
NiceLog System Administration. 

c.  Highlight a logger from the list, and click Modify.  The Modify Logger window appears as 
shown in figure 5-40.  Verify the correct TCPIP address and Logger Name.  Input channels 
connected to an audio source must be set to “Configured;” input channels not connected to an 
audio source must be set to “Not Configured.”  All output channels must be set to “Configured.”  
Click the Modify button to close the Modify Logger window.  Repeat this step for all loggers.  
Click Close to close the Loggers window. 
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Figure 5-40.  Modify Logger 

 

d.  Click on Users! at the top of the System Administration window.  The Users window 
appears.  Verify that only authorized users are listed. 

Note:  If an authorized user is not listed, the user must be added to the users list before it can be 
configured/modified.  Refer to TI 6670.11A, volume II for procedures to add a user in NiceLog 
System Administration. 

e.  Highlight a user and click Modify.  The Modify User window appears as shown in figure 
5-41.  Verify that each user is set in accordance with table 5-2.  Click the Channel Access button 
to verify input/output channels configured for each accessible logger.  Click Modify to close the 
Modify User window.  Repeat this step for all users.  Click Close to close the Users window, and 
then exit the System Administration application. 

Figure 5-41.  Modify User 
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Table 5-2.  Reproducer/Remote Workstation User Settings 

Caution:  User IDs and passwords must be entered in lowercase.  Failure to create user IDs and 
passwords with lowercase can lead to future problems.  Once the user IDs and passwords are created, 
the user can login using upper case, lower case, or mixed case.  
Note:  When the Password Reset box is checked, the password associated with the user being 
modified is reset.  The next time the user logs into any NiceLog application, they must leave the 
password field blank.  They will then be prompted to create a new password. 

System Administrator. 

User ID:  sysadm (not 
configurable).  
Name:  System Administrator 
(not configurable). 

The sysadm user is preset by the software and has access to all 
loggers, channels, and functions. 

Reproduce Only (@Rep) or Reproduce Only (@Rem).  A different user ID and password must be 
used for each user of this group. 

User ID:  Not configurable; user 
ID is initially set by the site 
when a new user is added.  
Name:  Must be Reproduce 
Only (@Rep) or Reproduce 
Only (@Rem). 

Loggers:  All loggers must be in the Accessible column.  
Channel Access:  For each logger, all input and output channels 
must be in the Accessible column.  
Type:  Must not be altered.  The program will change Type when 
necessary.  
Functions:  Must be set as follows: 

 Available 
Archive - Operations 
Archive - View Decks 
Configuration - View 
Maintenance - Self Test 
Recordings - Delete 
Recordings - Lock/Unlock 
Recordings - Playback 

Not Available 
Configuration - Modify 
Inputs - Monitor  
Inputs - Record Start/Stop 
Inputs - Setup 
Maintenance - Advanced 
Outputs - Setup 

Recorder Monitor (@Rep) or Recorder Monitor (@Rem).  A different user ID and password must be 
used for each user of this group. 

User ID:  Not configurable; user 
ID is initially set by the site 
when a new user is added.  
Name:  Must be Recorder 
Monitor (@Rep) or Recorder 
Monitor (@Rem). 

Loggers:  All recorder loggers must be in the Accessible column.  
Reproducer loggers must be in the Not Accessible column.  
Channel Access:  For each recorder logger, all input and output 
channels must be in the Accessible column.  
Type:  Must not be altered.  The program will change Type when 
necessary.  
Functions:  Must be set as follows: 

 Available 
Archive - View Decks 
Configuration - View 
Inputs - Monitor  
Maintenance - Self Test  
Recordings - Playback  

Not Available 
Archive - Operations 
Configuration - Modify 
Inputs - Record Start/Stop 
Inputs - Setup 
Maintenance - Advanced 
Outputs - Setup 
Recordings - Delete 
Recordings - Lock/Unlock 
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Table 5-2.  Reproducer/Remote Workstation User Settings (Continued) 

Reproducer Shutdown.  This user is only used to shutdown the reproducer logger when necessary. 

User ID:  Not configurable; user 
ID is initially set by the site 
when a new user is added.  
Name:  Must be Reproducer 
Shutdown. 

Loggers:  Only the reproducer logger must be in the Accessible 
column.  Recorder loggers must be in the Not Accessible column.  
Channel Access:  All input or output channels must be in the Not 
Accessible column.  
Type:  Must not be altered.  The program will change Type when 
necessary.  
Functions:  Must be set as follows: 

 Available 
Maintenance - Self Test 
Maintenance - Advanced 

Not Available 
Archive – Operations 
Archive - View Decks 
Configuration – Modify 
Configuration – View 
Inputs - Monitor 
Inputs - Record Start/Stop 
Inputs - Setup 
Outputs - Setup 
Recordings - Delete 
Recordings - Lock/Unlock 
Recordings – Playback 

5-13.  Verify Mandated Software Settings for Reproducer Logger. 

Note:  The software parameters not mentioned in this section either must not be used, are not 
available, or there are no mandated settings for that particular software parameter. 

Note:  In order to access all software parameters for verification, the sysadm user ID must be 
used to open the NiceLog Voice Logger application.  The application might have already been 
started by another user; exit and restart the application using the sysadm user ID. 

a.  At the reproducer workstation, login to the NiceLog Voice Logger application using the 
sysadm user ID.  Connect to the reproducer logger. 

b.  Setup Input Channels.  In the View pull-down menu, select Inputs.  From the Record pull-
down menu, select Setup all input channels.  The Setup All Input Channels window appears as 
shown in figure 5-42.  All input channel options must be set as shown in figure 5-42.  Click OK 
to close the Setup All Input Channels window.  If changes were made, click Yes to All at the 
confirmation window. 
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Figure 5-42.  Setup All Input Channels Window 

 

c.  Setup Output Channels.  From the Output drop-down box located in the upper right hand 
corner of the NiceLog Voice Logger window, select the first output channel as shown in figure 
5-43. 

Figure 5-43.  Output Drop-Down Box 

 

d.  From the Playback menu, select Setup output.  The Setup Output Channel window 
appears as shown in figure 5-44.  All output channel options must be set as shown in figure 5-44, 
with the exception of the Identification.  There are no mandated settings for the Identification.  
Click OK to close the Setup Output Channel window.  Repeat this step for the second and third 
output channels. 
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Figure 5-44.  Setup Output Channel Window 

 

Note:  The output identification must adequately describe the output channel purpose and/or 
destination depending on the site configuration.  The following are recommended 
identifications based on major configuration: 

 With Reproducer With IRR 

Output #1: Reproducer or Recorder Recorder 

Output #2: Recorder or Reproducer Remote WS or Not Used 

Output #3: Remote WS or Not Used Not Used 

e.  Configure Archive Decks.  From the Maintenance pull down menu, select Configure 
archive decks.  Deck 1 must be enabled and Deck 2 must be disabled as shown in figure 5-45.  
Click OK to close the Archive Decks window. 

Figure 5-45.  Configure Archive Decks 

 

f.  Setup Automatic Archiving.  From the Archive pull down menu, select Setup Automatic 
Archiving.  The Automatic Archiving Setup window appears.  The parameters must be set as 
shown in figure 5-46.  Click OK to close the Automatic Archiving Setup window.  At the 
warning window stating that automatic archiving is being disabled, click OK. 
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Figure 5-46.  Reproducer Automatic Archiving Setup 

 

g.  Configure Clock.  From the Maintenance pull down menu, select Configure clock.  Use 
internal clock must be enabled as shown in figure 5-47. 

Figure 5-47.  Configure Clock 

 

h.  Configure Automatic Deletion.  From the Maintenance pull-down menu, select Configure 
automatic deletion.  Delete oldest audio must be enabled as shown in figure 5-48. 

Figure 5-48.  Configure Automatic Deletion 

 

5-14.  Reset Passwords for a User. 

a.  At the workstation where user passwords are to be reset, login to the System 
Administration application using the sysadm user ID. 

b.  Click on Users! at the top of the System Administration window.  The Users window 
appears. 
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c.  Highlight a user and click Modify.  The Modify User window appears as shown in figure 
5-49. 

Figure 5-49.  Modify User Window 

 

d.  The Password Reset box is located in the upper right hand corner of the Modify User 
window.  Check the Password Reset box to enable it, and then click Modify to close the Modify 
User window.  When the password is reset, the password associated with the user becomes 
blank. 

e.  Close the System Administration application.  Login to the NiceLog Voice Logger 
application with the user ID that was modified in step d above and a blank password.  The 
software will prompt for a new password as shown in figure 5-50. 

Figure 5-50.  Change Password Prompt 

 

f.  Enter and confirm a new password for the user.  Click OK to close the Change Password 
window. 

Note:  The user can change his or her password at anytime by selecting the Change password 
option in the File drop-down menu of any NiceLog applications. 
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g.  Exit the NiceLog Voice Logger application.  Repeat this procedure for all other users 
listed in the System Administration application of this workstation.  Repeat this procedure for all 
recorder, IRR, reproducer, and remote workstations. 

5-15.  Change Password for System Administrator User ID. 

a.  At the workstation where the sysadm password is to be changed, login to the System 
Administration application using the sysadm user ID. 

b.  Select Change password from the File pull-down menu.  The Change password window 
appears as shown in figure 5-51. 

Figure 5-51.  Change Password Window 

 

c.  Enter and confirm a new password for the sysadm user.  Click OK to close the Change 
Password window. 

d.  Exit the System Administration application.  Repeat this procedure for all recorder, IRR, 
reproducer, and remote workstations. 

5-16.  Verify Proper Operation of the Remote Alarm. 

Note:  This test requires coordination with AT.  An alarm must be generated in order to test the 
remote alarm unit.  If there are multiple recorder loggers at a facility, the recorder logger used 
to test the remote alarm is at the facility’s discretion.  It is recommended that the recorder 
logger with the least number of active channels be used when performing this test.  The 
reproducer logger must not be used to test the remote alarm. 

Note:  In order to access all software parameters for verification, the sysadm user ID must be 
used to open the NiceLog Supervision application.  The application might have already been 
started by another user; exit and restart the application using the sysadm user ID. 

a.  Login to the NiceLog Supervision application using the sysadm user ID. 

b.  Click the Options icon on the toolbar.  The Supervision Options window appears.  Enable 
the last two alarms, Manual archiving and retrieval failure and Manual archiving and retrieval 
warning, as shown in figure 5-52.  Click OK to close the Supervision Options window, and 
minimize the NiceLog Supervision application. 



12/03/2008 JO 6670.13A 
 

5-34 

Figure 5-52.  Supervision Options Window – Test Configuration 

 

Note:  In order to access all software parameters for verification, the sysadm user ID must be 
used to open the NiceLog Voice Logger application.  The application might have already been 
started by another user; exit and restart the application using the sysadm user ID. 

c.  Login to the NiceLog Voice Logger application using the sysadm user ID.  Connect to the 
logger that will be used to perform the remote alarm test. 

d.  Click the Decks icon on the toolbar.  The Decks window appears as shown in figure 5-53.  
Verify that the Operation for Deck 1 and Deck 2 are both “Automatic Archiving” and the Status 
of one deck is “Archiving” and the other deck is “Ready.” 

Figure 5-53.  Decks Window 

 

e.  In the Decks window, click Eject on the deck that is in Ready mode.  The Status changes 
from “Ready” to “Ejecting.”  Wait for the DAT cartridge to eject. 



12/03/2008 JO 6670.13A 
 

5-35 

Note:  It is recommended to eject and re-insert the standby DAT cartridge on the same Julian 
date it was initially inserted; otherwise the archive life calculation will be off and will result in 
a “DAT Too Recent” error. 

f.  Remove the DAT cartridge from the logger.  On the DAT cartridge, move the write-
protect tab to the “protect” position. 

Note:  The DAT cartridge is write protected when the write-protect tab is open. 

g.  Insert the DAT cartridge into the deck used in step (e).  The Status changes from No DAT 
to Loading, and then to DAT is Write-Protected, as shown in figure 5-54.  Minimize the NiceLog 
Voice Logger application. 

Figure 5-54.  Decks Window with Write-Protect Error 

 

h.  Maximize the NiceLog Supervision application.  Highlight the logger being used to 
perform this test, and press the Test icon in the toolbar.  An alarm should appear in the 
Supervision window as shown in figure 5-55. 

Figure 5-55.  NiceLog Supervision Window with Write-Protect Error 

 

i.  Verify that an audible and visual alarm is generated at the remote alarm unit within five 
minutes.  Once this is verified, the test alarm may be muted by pressing the Alarm icon in the 
Supervision toolbar. 
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j.  Click the Options icon on the toolbar.  The Supervision Options window appears.  Disable 
the last two alarms, Manual archiving and retrieval failure and Manual archiving and retrieval 
warning, to restore the alarms to normal configuration.  Click OK to close the Supervision 
Options window. 

k.  Highlight the logger being used to perform this test, and press the Test icon on the toolbar 
to clear the alarm condition.  Click the Alarm icon on the toolbar to un-mute the alarm. 

l.  If necessary, exit the Supervision application and restart it using the user ID normally used 
for daily operation.  Minimize the application. 

m.  Maximize the NiceLog Voice Logger application.  In the Decks window, click Eject on 
the deck with the “DAT is Write-Protected” status.  The Status changes from “DAT is Write-
Protected” to “Ejecting,” and then to “No DAT.” 

n.  Remove the DAT cartridge from the logger, and move the write-protect tab on the DAT 
cartridge from the “protect” to the “write” position. 

o.  Insert the DAT cartridge back in to the corresponding deck. The Status changes from “No 
DAT” to “Loading,” and then to “Ready.” 

p.  Click Close to close the Decks window.  If necessary, exit the NiceLog Voice Logger 
application and restart it using the user ID normally used for daily operation. 

5-17.  Verify Normal Operation of the Workstation Fans. 

a.  Observe and listen from the back of the workstation computer for indications of abnormal 
operation of the blowers/cooling fan(s).  Abnormal indications can be abnormal squeeze/high-
pitch sound or abnormal movement.  It may be necessary to use a flash light or a bare hand to 
physically observe/feel the fan(s) operation. 

b.  Repeat this procedure for all recorder, IRR, reproducer, and remote workstations. 

5-18.  Check the Operation and Battery Condition of the UPS. 

a.  The UPS operation and battery condition must be checked by the PowerChute run time 
calibration.  The calibration process measures battery run time in relation to the current UPS 
Load.  A run time calibration temporary deeply discharges the UPS battery, reduces UPS run 
time and causes the Battery Capacity bar graph to display lower values. 

b.  Double-click on the Program Manager icon on the Windows desktop.  The Program 
Manager window opens.  Double-click on the PowerChute Plus: Windows icon.  The 
PowerChute Plus: Windows window appears as shown in figure 5-56. 
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Figure 5-56.  PowerChute PLUS Icon 

 

c.  Double click on the PowerChute PLUS icon.  The PowerChute PLUS main screen appears 
similar to figure 5-57. 

Figure 5-57.  PowerChute Main Screen 

 

Note:  The UPS battery capacity must be 100% to begin a run time calibration.  The Run Time 
Calibration can not begin if the UPS battery is less than 100% capacity. 

d.  Select Monitoring Preferences from the Configuration pull-down menu.  In the 
Monitoring Preferences window, select Run Time Remaining from the Bar Graph Type drop-
down list as shown in figure 5-58.  Click OK to close the Monitoring Preferences window. 
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Figure 5-58.  Monitoring Preferences 

 

e.  The left-most and right-most graphs on the PowerChute PLUS main screen will display 
Run Time Remaining and UPS Load, respectively.  Plot the Run Time versus UPS Load in the 
Rated Battery Capacity graph corresponding to the UPS model, shown in figure 5-59, figure 
5-60, and figure 5-61.  If the data point falls below the curve in the “Bad Area” of the graph, the 
UPS battery is failing and needs to be replaced.  No further testing can continue until the battery 
is replaced. 

Figure 5-59.  Rated Battery Capacity for Smart-UPS 1000 VA 
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Figure 5-60.  Rated Battery Capacity for Smart-UPS 1400 VA 
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Figure 5-61.  Rated Battery Capacity for Smart-UPS 1500 VA 
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f.  In the Diagnostics pull-down menu, select Initiate Run Time Calibration.  The Initiate Run 
Time Calibration option will change to Cancel Run Time Calibration. 

g.  The UPS battery will be discharged and the UPS will emit beep sound.  On the main 
screen, the Status field will change to “Calibrating” and the Last Two Events field will display 
“UPS run time calibration initiated,” as shown in figure 5-62.  The calibration process can take 
more than 30 minutes, depending on the UPS load and battery condition. 

Note:  During the calibration, if the run time reaches the critical point (below five minutes), the 
process should be canceled by selecting Cancel Run Time Calibration in the Diagnostics pull-
down menu. 

Figure 5-62.  UPS Run Time Calibration Initiated 

 

h.  When Run Time Calibration finished, the Status field will change to “On Line.”  The Last 
Two Events field will display “UPS run time calibration completed,” as shown in figure 5-63. 

Figure 5-63.  UPS Run Time Calibration Completed 
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i.  Select Monitoring Preferences from the Configuration pull-down menu.  In the 
Monitoring Preferences window, select Battery Capacity from the Bar Graph Type drop-down 
list as shown in figure 5-64.  Click OK to close the Monitoring Preferences window. 

Figure 5-64.  Monitoring Preferences 

 

j.  Wait for the battery capacity to recharge to 100% before continuing with this test.  
Recharging time varies from a minimum of two hours to a maximum of overnight, depending on 
UPS capacity, UPS load, and battery condition.  The PowerChute Plus application may be 
minimized if the workstation is needed while the battery is recharging. 

k.  When the battery capacity is fully charged to 100%, change the Monitoring Preferences 
back to Run Time Remaining.  The Run Time bar graph should display a properly calibrated run 
time value in minutes for the fully charged UPS. 

l.  Plot the Run Time versus UPS Load in the Rated Battery Capacity graph corresponding to 
the UPS model, shown in figure 5-59, figure 5-60, and figure 5-61.  If the data point falls below 
the curve in the “Bad Area” of the graph, the UPS battery is failing and needs to be replaced. 

m.  Exit the PowerChute application. 

5-19.  Clean the DAT Drive of Each Logger. 

Note:  The DAT drives used in the DVRS are self-contained units.  Cleaning is accomplished 
using a DAT cleaning cartridge.  The cleaning cartridge contains an abrasive-cleaning strip 
instead of the conventional recording medium.  Once a cleaning cartridge has been completely 
wound forward, it must be discarded and replaced.  Do not rewind a cleaning cartridge for 
reuse.  Consult the documentation provided with the DAT cleaning cartridge for the exact 
number of times it can be used. 

a.  The best time to clean a recorder logger DAT drive is at the scheduled DAT ejection time.  
Wait until the recorder logger has ejected the DAT cartridge at the facility’s scheduled ejection 
time.  Remove the ejected DAT cartridge from the DAT drive. 

b.  Insert a DAT cleaning cartridge into the DAT drive.  Once loaded, the cleaning cartridge 
will automatically perform the cleaning and then eject automatically. 
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Note:  The cleaning cycle typically takes between 15 to 30 seconds.  If the cleaning cartridge is 
immediately ejected (within five seconds) after insertion, it is at the end of its life and must be 
replaced. 

c.  Wait until the cleaning cycle is complete and the cleaning cartridge has been ejected from 
the DAT drive.  Remove the cleaning cartridge from the DAT drive. 

d.  Mark an “X” on the cleaning cartridge label to indicate it was used one time. 

Note:  When an “X” appears in every square on the label, the DAT cleaning cartridge must be 
discarded and replaced. 

e.  For recorder loggers, insert the appropriate DAT cartridge for automatic archiving. 

5-20.  Clean Logger Air Filters. 

Note:  The Dash-4 chassis only has one air filter to replace, located behind the left front panel 
door.  There are no air filter clips used with the air filter on the Dash-4 chassis. 

a.  The air filters are located inside the logger front panel doors.  Open and lower the logger 
front panel doors. 

b.  Gently press down and slide the air filter clips forward (away from chassis) until clear of 
retainers. 

c.  Remove the air filters from the clips and rinse them with water. 

d.  Wipe down the door grates and the clips with a damp cloth. 

e.  Wait until the filters are fully dry before putting them back into the logger. 

5-21.  Clean Cassette Audio Heads, Pinch Rollers, and Capstan Shafts.  Use cotton swabs 
dipped in isopropyl alcohol to clean the cassette audio heads, pinch rollers and capstan shafts.  
There must be no visible buildup, dirt, or oxide on any of the rotating parts in the cassette tape 
path.  The audio heads can also be cleaned using the cassette-cleaning cartridge.  The cassette-
cleaning cartridges are to be obtained locally. 
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Section 2.  As-Required Performance Checks and Maintenance Tasks 

5-22.  Verify 600 Ohm Termination Resistor on Each Audio Input Channel.  All DVRS 
input channels except those that record telephone lines must be terminated at 600 Ohms for 
proper operation.  Visually inspect the 66-blocks located in the DVRS rack for the presence of 
600 Ohm termination resistors. If 600 Ohm resistors are not present, ensure that a double 
termination condition will not exist before adding termination resistors. 

Note:  Most facilities operate the DVRS in parallel with another recorder prior to 
commissioning.  Normally, the other recorder is already 600 Ohm terminated; therefore the 
DVRS must not be terminated until the older recorder terminations are removed, as to avoid 
double termination.  Two sets of 66-blocks are provided with the DVRS during installation: 
one set does not have 600 Ohm terminations and is used when the DVRS is connected in 
parallel with the older recorder; the other set is 600 Ohm terminated and must be used after the 
older recorder terminations are removed. 

5-23.  Verify that All Bridge Clips on Terminal Blocks are in Place.  All input channels 
(including unused channels) to the recorder loggers must have bridge clips in place on the 
terminal 66-blocks.  Placing the bridge clips on unused channels ensures that all input channels 
are 600 Ohm terminated, preventing unused input channels from erroneously recording. 

5-24.  Verify Cassette Deck Channel Assignments.  AT requires specific stereo cassette deck 
channel assignments for time code and audio when making legal cassette re-recordings.  Time 
code must be placed on the right channel and audio must be placed on the left channel of the 
cassette recorder.  Visually inspect the reproducer/IRR logger, and verify that audio output #1 
(the top RJ-11 connector on the Logger Auxiliary Function (LAF) board) is connected to the left 
channel input and the time code output (bottom BNC connector on the LAF Input/Output (I/O) 
board) is connected to the right channel input of the cassette recorder. 

5-25.  Verify Software Versions Installed on Workstations. 

Note:  The software contained on the DVRS must match exactly with the version of software 
outlined in chapter 3, paragraph 3-31 and 3-34.  Software programs/packages that are not 
specifically contained in paragraph 3-31 and 3-34 must not be loaded onto or executed within 
the DVRS platforms. 

a.  At the workstation, double-click on the Program Manager icon on the Windows desktop.  
In the Program Manager window, select About Program Manager in the Help pull-down menu.  
Verify the Windows version is 3.11.  Click OK to close the window. 

b.  At the workstation, login to NiceLog Voice Logger application using the sysadm user ID.  
In the Help pull-down menu, select About.  Verify the NiceLog Voice Logger application is 
version 5.12, as shown in figure 5-65.  Click OK to close the About window, and then exit the 
Voice Logger application. 
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Figure 5-65.  NiceLog Voice Logger Software Version 

 

Note:  In order to access all software parameters for verification, the sysadm user ID must be 
used to open the NiceLog Supervision application.  The application might have already been 
started by another user; exit and restart the application using the sysadm user ID.  After 
software version verification, if necessary, exit the Supervision application and restart it using 
the user ID normally used for daily operation.  Minimize the application. 

c.  At the workstation, login to NiceLog Supervision application using the sysadm user ID.  
In the Help pull-down menu, select About.  Verify the NiceLog Supervision application is 
version 5.12, as shown in figure 5-66.  Click OK to close the About window, and then exit the 
Supervision application. 

Note:  The NiceLog Supervision application is not installed on the reproducer or remote 
workstsations. 

Figure 5-66.  NiceLog Supervision Software Version 

 

d.  At the workstation, login to NiceLog System Administration application using the sysadm 
user ID.  In the Help pull-down menu, select About.  Verify the NiceLog System Administration 
application is version 5.11, as shown in figure 5-67.  Click OK to close the About window, and 
then exit the Supervision application. 

Figure 5-67.  System Administration Version 
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5-26.  Verify Software Versions Installed on Loggers. 

Note:  For recorder loggers, this procedure requires a recording service outage coordinated 
with AT. 

Note:  The software contained on the DVRS must match exactly with the version of software 
outlined in chapter 3, paragraph 3-32, 3-33 and 3-34.  Software programs/packages that are not 
specifically contained in paragraph 3-32, 3-33 and 3-34 must not be loaded onto or executed 
within the DVRS platforms. 

a.  In the NiceLog Supervision application, disable alarms for the target logger. 

b.  Remove the monitor and keyboard from the workstation, and connect them to the target 
logger. 

c.  The software version is displayed on the top line of the blue screen.  Verify that the logger 
NiceLog software version is 5.12. 

d.  Press the <q> key to exit the logger software.  The C:\DSN1000> prompt appears at the 
bottom of the screen. 

e.  At the C:\DSN1000> prompt, type: 

ver<Enter> 

f.  Verify the listed MS-DOS version is 6.22. 

g.  At the C:\DSN1000> prompt, type: 

c:\qemm\qemm /sum<Enter> 

h.  Verify the listed QEMM version is either 7.0 or 7.5. 

i.  At the C:\DSN1000> prompt, type: 

cd \pctcp<Enter> 

j.  At the C:\PCTCP> prompt, type: 

ethdrv<Enter> 

k.  Verify that the listed PCTCP version is 2.1. 

l.  At the C:PCTCP> prompt, type: 

cd \dsn1000<Enter> 
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m.  At the C:\DSN1000> prompt, type: 

dsn1000<Enter> 

n.  Remove the monitor and keyboard from the logger, and connect them back to the 
workstation. 

o.  Wait until the SYS READY LED is illuminated, and then connect to the target logger 
from NiceLog Voice Logger. 

p.  Re-insert the DAT tapes that were ejected during logger shutdown. 

q.  In NiceLog Supervision, enable alarms for the target logger. 

r.  Repeat this process for all recorder, reproducer, and IRR loggers. 

5-27.  Create or Update the Workstation Configuration Backup Disk(s). 

Note:  The workstation configuration backup disk contains the workstation configuration files 
and will be used to quickly restore the software settings when the workstation is replaced, 
software is reloaded, or passwords are lost.  The workstation configuration backup disk must 
be updated or recreated whenever changes are made to the configuration of the workstation.  
The workstation configuration includes the communication parameters, logger accounts, user 
accounts, and recording schedules. 

a.  Obtain the configuration backup disk labeled “Workstation Settings” that corresponds to 
the target workstation.  Move the protect tab of the disk to the writable position.  Insert the disk 
into the workstation floppy drive. 

Note:  If the disk has not been created yet or has been lost, use a brand new 3 ½ -inch 
formatted high-density floppy disk.  It is important that the floppy disk has never been used 
before to avoid virus contamination. 

b.  Exit all software applications on the target workstation, including NiceLog Voice Logger 
and Supervision. 

c.  Exit Microsoft Windows by selecting Exit Windows from the File pull-down menu in the 
Program Manager window. 

d.  At C:\> prompt, type: 

format a: /u<Enter> 

e.  The system will format the floppy disk and prompt for a volume label.  Type the 
workstation ID number followed by “Settings.”  For example: 

100Settings<Enter> 

f.  The system will prompt for formatting another floppy disk.  Type: 
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n<Enter> 

g.  At C:\> prompt, type: 

copy onnet\pctcp.ini a:<Enter> 

copy ws\nicelog.ini a:<Enter> 

copy ws\winmult.ini a:<Enter> 

copy ws\wrkpr.dat a:<Enter> 

copy ws\wrkus.dat a:<Enter> 

h.  If a recording schedule is setup, PROGREC.DAT also needs to be copied.  If necessary, 
type: 

copy ws\progrec.dat a:<Enter> 

i.  Verify the presence of copied files on the floppy disk by performing a directory listing.  
Type: 

dir a:<Enter> 

j.  Remove the floppy disk from the floppy drive. 

k.  Label the floppy disk with the date, site ID, workstation ID and the word “Workstation 
Settings.” 

l.  Move the write-protect tab on the floppy disk to the read-only position. 

m.  Store the backup floppy disk with other software disks for this computer workstation.  
Discard any old configuration backup disks for the workstation. 

n.  Reboot the computer workstation using the power switch. 

o.  Restore the workstation to normal operation. 

p.  Repeat this procedure for all recorder, reproducer, IRR, and remote workstations. 

5-28.  Create or Update the Logger Configuration Backup Disk(s). 

Note:  For recorder loggers, this procedure requires a recording service outage. 

Note:  The logger configuration backup disk contains the logger configuration files and will be 
used to quickly restore the software settings when the hard drive is replaced or software is 
reloaded.  The logger configuration backup disk must be updated or recreated whenever 
changes are made to the configuration of the logger.  The logger configuration includes the 
communication parameters and channel configuration. 
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a.  Obtain the configuration backup disk labeled “Logger Settings” which corresponds to the 
target logger.  Move the protect tab of the disk to the writable position.  Insert the disk into the 
logger floppy drive. 

Note:  If the disk has not been created yet or has been lost, use a brand new 3 ½ -inch 
formatted high-density floppy disk.  It is important that the floppy disk has never been used 
before to avoid virus contamination. 

b.  In the NiceLog Supervision application, disable alarms for the target logger. 

c.  In the NiceLog Voice Logger application, connect to the target logger. 

d.  Under the Maintenance pull-down menu, select Shutdown logger.  At the confirmation 
prompt click Yes.  The DAT cartridge should eject.  Retain the DAT cartridge for re-insertion 
later in this procedure.  Wait for the message stating that the logger was shut down. 

e.  Remove the monitor and keyboard from the workstation, and connect them to the target 
logger. 

f.  The C:\DSN1000> prompt appears.  To clear the screen and return to the root directory 
C:\> prompt, type: 

cls<Enter> 

cd\<Enter> 

g.  At the C:\> prompt, type: 

format a: /u<Enter> 

h.  The system will format the floppy disk and prompt for a volume label.  Type the logger 
ID number followed by “Settings.”  For example: 

101Settings<Enter> 

i.  The system will prompt for formatting another floppy disk.  Type: 

n<Enter> 
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j.  At the C:\> prompt, type: 

copy config.sys a:<Enter> 

copy pctcp\pctcp.ini a:<Enter> 

copy audio\aud-work\resource.dat a:<Enter> 

copy audio\aud-work\hardware.cfg a:<Enter> 

copy audio\aud-work\paramsav.dat a:<Enter> 

k.  Verify the presence of copied files on the floppy disk by performing a directory listing.  
Type: 

dir a:<Enter> 

l.  Remove the floppy disk from the floppy drive. 

m.  Label the floppy disk with the date, site ID, logger ID and the word “Logger Settings.” 

n.  Move the write-protect tab on the floppy disk to the read-only position. 

o.  Store the backup floppy disk with other software disks for this logger.  Discard any old 
configuration backup disks for the logger. 

p.  Remove the monitor and keyboard from the logger, and connect them back to the 
workstation. 

q.  Reboot the logger using the power switch. 

r.  Wait until the SYS READY LED is illuminated, and then connect to the target logger 
from NiceLog Voice Logger. 

s.  Restore recording operation, insert DAT cartridges for automatic archiving, and re-enable 
alarms for the target logger. 

t.  Repeat this procedure for all recorder, reproducer, and IRR loggers 

5-29.  Verify GPS Receiver Settings.  The GPS receiver firmware parameters must be set as 
outlined in table 5-3, following the operational tips below: 

a.  During normal operation, the GPS receiver screen displays time, status, or position.  To 
enter a specific function, first press <FUNC/ENTR> then the function number (including the 
leading zero for a function less than ten). 

b.  If the message “Function not implemented” is displayed, the function is not available on 
the receiver.  In that circumstance, there is no required setting/configuration (entry) for that 
function; the display will revert to STATUS, TIME, or POSITION statement. 
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c.  After the function is selected, the display will show one of several options available under 
that function.  The left or right arrow keys are used to position the cursor beneath the character to 
edit.  The up or down arrow keys are used to scroll through the possible choices for that option.  
When the display indicates the desired data, press <FUNC/ENTR> to enter a choice and go to 
the next option.  When the last option within the function has been configured and 
<FUNC/ENTR> is pressed again, the display will revert to STATUS, TIME, or POSITION 
statement. 

d.  At any time, the <TIME> or <STATUS> keys may be pressed to return to the standard 
time or status display and exit the function selected for configuration without saving. 

Table 5-3.  GPS Settings 

Function Parameter Operation/Setting 

01 Time Zone Entry/Request Press FUNC/ENTR 01 

 Time zone hr:min 
 ±00:00 

Press FUNC/ENTR 

02 12/24 Hour Format 
Entry/Request 

Press FUNC/ENTR 02 

 12/24 hr Format 
 24 

Press FUNC/ENTR 

03 Time/Date Entry/Request Caution:  Do not perform the Time/Date Entry (Function 03) 
while the DVRS equipment is recording and receiving 
external time code from the GPS receiver.  The time/date 
must only be changed when all of the recorder loggers have 
stopped recording or switched to internal time source.  
Changing the time or date while recording will corrupt the 
recording database and cause loss of recording service.  If 
Function 03 is inadvertently selected, press <TIME> to 
bypass the selection. 

Press FUNC/ENTR 03 

 Date-time 
 UTC 

Press FUNC/ENTR 

 Date-time 
 MM/DD/YY (enter the present Universal Time Coordinated 
(UTC) date) 

Press FUNC/ENTR 
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Table 5-3.  GPS Settings (Continued) 

Function Parameter Operation/Setting 

   Date-time 
 HH:MM:SS (enter the present UTC time) 

Note:  The Date-time reverts back to 00:00:00. 

Press FUNC/ENTR 

04 Serial Port Setup Press FUNC/ENTR 04 

 Ser port setup 
 Baud rate 9600 

Press FUNC/ENTR 

 Ser port setup 
 Data bits 7 

Press FUNC/ENTR 

 Ser port setup 

 Parity even 

Press FUNC/ENTR 

 Ser port setup 
 Stop bits 1 

Press FUNC/ENTR 

05 Time Quality Enable/Setup Press FUNC/ENTR 05 

 Time quality 
 on 

Press FUNC/ENTR 

 First tq flag: 
 00000001000ns 

Press FUNC/ENTR 

 Second tq flag: 
 00000010000ns 

Press FUNC/ENTR 

 Third tq flag: 
 00000100000ns 

Press FUNC/ENTR 
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Table 5-3.  GPS Settings (Continued) 

Function Parameter Operation/Setting 

   Fourth tq flag: 
 00001000000ns 

Press FUNC/ENTR 

06 Keypad Lockout Enable Press FUNC/ENTR 06 

 Keypad Lock 
 off 

Press FUNC/ENTR 

16 Emulation Mode Enable Press FUNC/ENTR 16 

 Emulation mode 
 off 

Press FUNC/ENTR 

18 Software Version Request 

 

 

 

 

Press FUNC/ENTR 18 

 TRUETIME XL 
 XXX1 sys ver 030 

Press any of the arrow keys 

 GPS-XL V1.047 
 182-6064v008 

Press FUNC/ENTR 

26 Program Pulse Output Press FUNC/ENTR 26 

 PPO Start Time 
 000:00:00:00.000 

Press FUNC/ENTR 

 PPO Stop Time 
 000:00:00:00.000 

Press FUNC/ENTR 

30 IEEE-488 Port Setup Press FUNC/ENTR 30 

 Ieee-488 address 
 05 

Press FUNC/ENTR 

 

1May display: SV6, ACE, etc.  All else must match exactly. 
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Table 5-3.  GPS Settings (Continued) 

Function Parameter Operation/Setting 

51 Antenna Cable Delay 
Entry/Request 

Press FUNC/ENTR 51 

 Ant. cable delay 
 +220ns 

Press FUNC/ENTR 

52 Distribution Cable Delay 
Entry/Request 

Press FUNC/ENTR 52 

 Dist cable delay 
 ±000000000ns 

Press FUNC/ENTR 

Note:  The GPS receiver must be set to operate in AUTO mode (Function 53) at power up.  During normal 
operation, the AUTO mode automatically switches to TIME mode.  The GPS receiver will reset if change is 
made to this function.  To leave this function unchanged press the <STATUS> key. 

53 Operation Mode 
Entry/Request 

At power up 

Press FUNC/ENTR 53 

 AUTO / TIME Mode 
 AUTO 

Press FUNC/ENTR 

 Change to AUTO  mode? 

 Yes 

Press FUNC/ENTR 

Normal operation 

Press FUNC/ENTR 53 

 AUTO / TIME Mode 
 TIME 

Press STATUS 

 

55 Altitude Units Press FUNC/ENTR 55 

 Altitude mode 
 Feet 

Press FUNC/ENTR  

65 Satellite Select Press FUNC/ENTR 65 

 Sat# XX 
 Enabled 

Press FUNC/ENTR until all satellites are Enabled. 
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Table 5-3.  GPS Settings (Continued) 

Function Parameter Operation/Setting 

66 Daylight Savings Enable Press FUNC/ENTR 66 

 Daylight Saving 
 Off 

Press FUNC/ENTR 

68 GPS Year Entry Press FUNC/ENTR 68 

 Set current year 
 YYYY (current 4 digit Year) 

Press FUNC/ENTR 

 Save year? 
 Yes 

Press FUNC/ENTR 

69 Select Local/Standard/ 
GPS/UTC Time 

Press FUNC/ENTR 69 

 Select Time Type 
 UTC 

Press FUNC/ENTR 

Note:  Status indications under Function 73 may not display OK until the GPS is synchronized. 

73 Alarm Settings Press FUNC/ENTR 73 

 Clock Status 
 GPS: Locked 

Press FUNC/ENTR 

 Position Status 
 Position Approx. 

 (or Full Accuracy) 

Press FUNC/ENTR 

 Major Alarm: En 
 PLL: OK 

Press FUNC/ENTR 

 Major Alarm: En 
 Antenna: OK 

Press FUNC/ENTR 

 Major Alarm: En 
 Receiver: OK 

Press FUNC/ENTR 



12/03/2008 JO 6670.13A 
 

5-55 

Table 5-3.  GPS Settings (Continued) 

Function Parameter Operation/Setting 

   Major Alarm: En 
 NV RAM: OK (or Error) 

Press FUNC/ENTR 

 Clear NV RAM 
 fault? Yes (not always displayed) 

Press FUNC/ENTR 

 Major Alarm: En 
 Timeout: OK 

Press FUNC/ENTR 

 Timeout delay 
 01800s 

Press FUNC/ENTR 

 Minor Alarm: En 
 Time Error: OK 

Press FUNC/ENTR 

 Time threshold 
 0 ns 

Press FUNC/ENTR 

 Minor Alarm:  En 
 Tracking: OK 

Press FUNC/ENTR 

 Minor Alarm: En 
 Tuning: OK 

Press FUNC/ENTR 

 Minor Alarm: En 
 NV Battery: OK 

Press FUNC/ENTR 

 Minor Alarm: En 
 Acquisition: OK 

Press FUNC/ENTR 

 Led Blink: En 

Press FUNC/ENTR 
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Table 5-3.  GPS Settings (Continued) 

Function Parameter Operation/Setting 

   PowerOn m Alarm 
 Suppress 0s 

Press FUNC/ENTR 

 Clear Alarm 
 Latch? Yes 

Press FUNC/ENTR 

 Save Alarm Mask? 
 Yes (not always displayed) 

Press FUNC/ENTR 

Press TIME to exit Function 73. 

79 Warm Start Caution:  Do not perform the Warm Start (Function 79) while 
the DVRS equipment is recording and receiving external time 
code from the GPS receiver.  The Warm Start function must 
only be performed when all of the recorder loggers are 
configured for internal time source.  Otherwise, corruption 
will occur to the recording database and a loss of recording 
service will result.  This function issues a reset command to 
the GPS when all other diagnostics have failed to 
synchronize the GPS receiver to satellites.  If Function 79 is 
inadvertently selected, press <TIME> to bypass the selection.

No required setting for this function. 

 

5-30.  Verify the GPS Time Code Format and Signal Levels. 

a.  This test requires the following test equipment: 

(1)  An oscilloscope with a high impedance probe (to prevent loading of the circuit by the 
oscilloscope) with a BNC connector. 

(2)  A Jack/Plug/Jack BNC Tee adapter. 

(3)  A frequency counter may be used to determine the signal frequency. 

b.  The time code signal provided to the recorder loggers from the GPS receiver must be 
format IRIG-B.  Observe the connection at the rear of the GPS receiver.  Verify that the time 
code cable (coaxial cable) is connected to the output connector labeled IRIG-B on the GPS 
receiver. 
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c.  The time code cable from the GPS receiver output is connected to the connector J2 on the 
LAF I/O board at the rear of the logger.  If there are more than two loggers, the loggers are daisy 
chained using BNC Tee adapters.  If a BNC Tee adapter is not present at the last logger, which is 
at the end of the daisy-chained coaxial cable, install one.  Connect the oscilloscope to the last 
BNC Tee adapter. 

d.  The time code signal must be amplitude modulated 1 KHz.  Observe the time code signal 
displayed on the oscilloscope screen.  Verify that the signal waveform is similar to figure 5-68 
below. 

Figure 5-68.  IRIG-B Time Code Signal Waveform 

 

e.  Verify that the signal levels are within the range allowed by the standards and tolerances 
stated in chapter 3. 

5-31.  Verify Recorder Logger Performance Characteristics. 

a.  Test Equipment Required.  These tests are written assuming that the facility is using the 
following test equipment. 

(1)  A transmission impairment measuring set (TIMS) HP-4935A, transmission test set 
model 44 (TTS-44), or equivalent. 

(2)  A 48-position, miniature bantam telex patch panel, or equivalent, attached to the 66-
blocks. 

(3)  One Telco 310 male to miniature-bantam phone plug test cable to send test tones 
through the patch panel. 

(4)  One RCA female to Telco 310 male test cable to measure signal level output from 
the logger.  This test cable is made locally.  The tip of the RCA female connector must be 
connected to the tip of the male Telco 310 connector.  The sleeve of the RCA female connector 
must be connected to the ring of the Telco 310 male connector. 
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Note:  To reduce cabling confusion, it is recommended to make the RCA female to Telco 310 
male test cable with a 150 Ohm termination.  If the test cable already has a 150 Ohm 
termination resistor, the RJ-11 male to RCA male cable containing 150 Ohm resistor (below) is 
not required for testing. 

(5)  An RJ-11 male to RCA male cable containing a 150 Ohm resistor.  This cable is used 
as an audio output cable provided with the reproducer equipment.  It is connected to the left input 
of the cassette recorder. 

b.  Test setup. 

(1)  Configure the transmit side of the test set for 600 Ohm impedance.  Configure the 
receive side of the test set for 600 Ohm termination mode. 

(2)  Obtain the 150 Ohm terminated audio cable.  Connect the RCA male connector of 
the audio cable to the RCA female connector of the test cable (receive side). 

(3)  At the rear of the target logger, disconnect the cable from the LAF board audio 
output #1 (top RJ-11 jack). 

(4)  Connect the RJ-11 male connector of the 150 Ohm terminated audio cable to the 
LAF audio output #1 of the target logger.  The test cable interconnection is shown in figure 5-69. 

(5)  The following NiceLog software settings are assumed true for these tests: 

(a)  The NiceLog Voice Logger application is logged into using the sysadm user ID. 

(b)  The NiceLog Voice Logger application is connected to the target logger. 

(c)  All input and output channels are setup according to paragraph 5-11. 

Note:  Evaluation of performance characteristics requires that logger channels be taken out of 
service with the removal of the audio source (by disconnecting the audio cable from the line 
side of the recorder patch panel) to ensure only the test tones are recorded.  Each audio input 
cable supports 24 channels.  It is reccommended to perform the tests 24 channels at a time to 
reduce the impact to the recording service. 

(d)  Remove the audio input cable from the line side of the recorder patch panel. 

c.  System Gain. 

(1)  Configure the transmission test set to measure level/frequency.  With the test set, 
transmit a -10 dBm, 1004 Hz test tone. 

(2)  Insert the test tone into an input channel via the patch panel. 

(3)  In NiceLog Voice Logger, highlight the channel under test, and click the Play icon.  
Verify that the correct tone is being played by fast forwarding the playback indicator to within 10 
seconds of the current time. 
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Figure 5-69.  Test Cable Interconnection for Recorder Logger 
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(4)  Log the output level (in dBm) read from the receive side of the transmission test set.  
Compare the output level with the input level (-10 dBm).  The system gain (the difference 
between the input level and the output level) must be 0 dB ± 3 dB. 

(5)  Repeat steps (2) through (4) for all remaining input channels. 

d.  Audio Frequency Response. 

(1)  Configure the transmission test set to measure level/frequency.  With the test set, 
transmit a -10 dBm, 300 Hz test tone. 

(2)  Insert the test tone into an input channel via the patch panel. 

(3)  In NiceLog Voice Logger, highlight the channel under test, and click the Play icon.  
Verify that the correct tone is being played by fast forwarding the playback indicator to within 10 
seconds of the current time. 

(4)  Log the output level (in dBm) read from the receive side of the transmission test set.  
Compare the output level with the input level (-10 dBm).  The audio frequency response (the 
difference between the input level and the output level) must be 0 dB ± 3 dB. 

(5)  Repeat steps (2) through (4) for all remaining input channels. 

(6)  Repeat steps (1) through (5) with a -10 dBm test tone at 600 Hz and 2700 Hz. 

e.  Noise-With-Tone. 

(1)  Configure the transmission test set to measure Noise With Tone (or Notch filter) with 
C-message weighting.  With the test set, transmit a -30 dBm, 1004 Hz test tone. 

(2)  Insert the test tone into an input channel via the patch panel. 

(3)  In NiceLog Voice Logger, highlight the channel under test, and click the Play icon.  
Verify that the correct tone is being played by fast forwarding the playback indicator to within 10 
seconds of the current time. 

(4)  Log the C-Notched noise level (in dBrnC) read from the receive side of the 
transmission test set.  The C-Notched noise level should be less than 45 dBrnC. 

(5)  Repeat steps (2) through (4) for all remaining input channels. 

f.  Restore the recording service. 

(1)  Reconnect the audio input cables to the line side of the recorder patch panel.  Verify 
that the activity indications are displayed on the screen. 

(2)  Reconnect the logger audio output cable to the LAF board audio output #1 (top RJ-11 
jack). 
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5-32.  Verify Reproducer Logger Performance Characteristics. 

a.  Test Equipment Required.  These tests are written assuming that the facility is using the 
following test equipment. 

(1)  A TIMS HP-4935A, TTS-44, or equivalent. 

(2)  A reference DAT cartridge containing test tones of -10 dBm at 1004 Hz, -10 dBm at 
300 Hz, -10 dBm at 600 Hz, and -10 dBm at 2700 Hz.  If there is no reference DAT cartridge 
available, refer to Appendix B for the procedure to create a reference DAT cartridge. 

(3)  One RCA female to Telco 310 male test cable to measure signal level output from 
the logger.  This test cable is made locally.  The tip of the RCA female connector must be 
connected to the tip of the male Telco 310 connector.  The sleeve of the RCA female connector 
must be connected to the ring of the Telco 310 male connector. 

Note:  To reduce cabling confusion, it is recommended to make the RCA female to Telco 310 
male test cable with a 150 Ohm termination.  If the test cable already has a 150 Ohm 
termination resistor, the RJ-11 male to RCA male cable containing 150 Ohm resistor (below) is 
not required for testing. 

(4)  An RJ-11 male to RCA male cable containing a 150 Ohm resistor.  This cable is used 
as an audio output cable provided with the reproducer equipment.  It is connected to the left input 
of the cassette recorder. 

b.  Test setup. 

(1)  Configure the transmit side of the test set for 600 Ohm impedance.  Configure the 
receive side of the test set for 600 Ohm termination mode. 

(2)  Obtain the 150 Ohm terminated audio cable.  Connect the RCA male connector of 
the audio cable to the RCA female connector of the test cable (receive side). 

(3)  At the rear of the reproducer logger, disconnect the cable from the LAF board audio 
output #1 (top RJ-11 jack). 

(4)  Connect the RJ-11 male connector of the 150 Ohm terminated audio cable to the 
LAF audio output #1 of the target logger.  The test cable interconnection is shown in figure 5-70. 

(5)  The following NiceLog software settings are assumed true for these tests: 

(a)  The NiceLog Voice Logger application is logged into using the sysadm user ID. 

(b)  The NiceLog Voice Logger application is connected to the reproducer logger. 

(c)  All input and output channels are setup according to paragraph 5-13. 
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Figure 5-70.  Test Cable Interconnection for Reproducer Logger 
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c.  Retrieve test tone recording from reference DAT cartridge. 

Note:  If the test tone recording already exists on the hard drive, it is not necessary to retrieve 
the recording again. 

(1)  At the reproducer workstation, login to the NiceLog Voice Logger application and 
connect to the reproducer logger. 

(2)  In the Archive pull-down menu, select Retrieval.  The software will prompt for 
inserting a DAT.  Insert the reference DAT cartridge into the reproducer logger DAT drive, and 
press OK. 

(3)  The Decks dialog box appears.  Wait for the cartridge to finish loading and the Status 
to change to “Ready,” and then click the Deck 1 button 

(4)  The DAT Contents window appears, as shown in figure 5-71.  Highlight the test tone 
recording, and then click the Start Retrieval button. 

Figure 5-71.  Retrieval DAT Contents 

 

(5)  The Retrieval From DAT To Disk window appears.  Select From the start and To the 
end, as shown in figure 5-72.  Click the Retrieve button. 

Figure 5-72.  Retrieval From DAT To Disk 
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(6)  Click Close to close the DAT Contents window.  In the Decks window, the Status 
will change from “Ready” to “Retrieving.”  When the Status changes back to “Ready,” retrieval 
is complete.  Click Close to close the Decks window. 

(7)  Click the Deck 1 button.  In the DAT Contents window, click Quit Retrieval.  Click 
OK at the prompt “Ejecting DAT from deck 1” and then wait for the DAT cartridge to be 
ejected.  Click Close to close the Decks window and remove the DAT cartridge. 

(8)  In the View pull-down menu, select Recordings.  In the View pull-down menu, select 
Filter.  In the Filter Recordings window, select Last retrieved.  Click OK to close the Filter 
Recordings window. 

(9)  The screen displays the test tone recording that was just retrieved. 

d.  Audio Frequency Response. 

(1)  Configure the transmission test set to measure level/frequency. 

(2)  In NiceLog Voice Logger, highlight the test tone recording that has been retrieved 
from the reference DAT cartridge to the reproducer logger hard drive.  Click the Play icon.  
Verify which frequency is being played by observing the reading from the receive side of the 
transmission test set. 

(3)  Log the output levels (in dBm) read from the receive side of the transmission test set 
for each test tone: -10 dBm at 300 Hz, 600 Hz, 1004 Hz, and 2700 Hz.  Compare each output 
level with the input level (-10 dBm).  The audio frequency response (the difference between the 
input level and the output level) must be 0 dB ± 3 dB. 

e.  Noise-With-Tone. 

(1)  Configure the transmission test set to measure Noise With Tone (or Notch filter) with 
C-message weighting. 

(2)  In NiceLog Voice Logger, highlight the test tone recording that has been retrieved 
from the reference DAT cartridge to the reproducer logger hard drive.  Click the Play icon.  
Verify that the -30 dBm, 1004 Hz tone is being played by observing the reading from the receive 
side of the transmission test set. 

(3)  Log the C-Notched noise level (in dBrnC) read from the receive side of the 
transmission test set.  The C-Notched noise level should be less than 45 dBrnC. 

f.  Restore normal reproducer setup. 

(1)  The test tone recording can be deleted from the reproducer logger hard drive.  To 
delete the test tone recording, highlight the recording and select Delete recording from the 
Playback pull-down menu. 
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(2)  Reconnect the logger audio output cable to the LAF board audio output #1 (top RJ-11 
jack). 

5-33.  Verify Normal Operation of Logger Cooling Fans.  At any time the logger cover is 
opened, verify the operation of the logger cooling fans.  When the logger is powered on, observe 
and listen for indications of abnormal operation of the blowers/cooling fan(s). 

5-34.  Calibrate Cassette Player/Recorder. 

Note:  The DVRS logger does not provide balanced time code (IRIG-B) and audio signal 
levels to the cassette player/recorder.  When comparing the signal levels between the time code 
and a -10 dBm, 1004 Hz test tone output from a logger during playback, the time code signal is 
12 dB higher in magnitude than the test tone.  The cassette player/recorder must be calibrated 
such that both time code signal and a -10 dBm, 1004 Hz test tone levels are displayed on the 
cassette deck Volume Unit (VU) meter at 0 dB ± 3 dB when playing back from NiceLog Voice 
Logger.  Before making a certified re-recording cassette copy, the cassette player/recorder must 
be calibrated with the logger in which the source recording(s) is/are located.  This procedure is 
written assuming that the facility is using a cassette deck that does not have a left-right balance 
control or individual input control knobs and that the time code attenuator (TCA) has been 
installed for balancing the input levels of the cassette deck.  For facilities where the left-right 
balance control is available, the input levels of the cassette deck are balanced using the control. 

Note:  This procedure requires a -10 dBm, 1004 Hz test tone on the logger hard drive with 
which the cassette player/recorder is being calibrated.  The test tone can be retrieved from the 
reference DAT cartridge.  If the reference DAT cartridge is not available, refer to Appendix B 
for the procedure to create a reference DAT cartridge.  If the test tone recording already exists 
on the hard drive, it is not necessary to retrieve the recording again. 

(1)  At the reproducer workstation, login to NiceLog Voice Logger using the sysadm user 
ID, and connect to the reproducer logger. 

(2)  In the upper right hand corner of the NiceLog Voice Logger window, select the 
output channel that is physically connected to the cassette player/recorder.  Verify that the output 
channel is setup according to paragraph 5-13. 

(3)  Insert a blank recordable cassette tape into the cassette deck.  Rewind the cassette to 
the beginning of the tape.  Place the cassette deck in the record/pause mode.  Refer to TI 
6670.11A for information on the cassette deck operations and the record/pause mode. 

(4)  Retrieve the -10 dBm, 1004 Hz test tone recording from the reference DAT cartridge 
as described in paragraph 5-32c. 

(5)  In NiceLog Voice Logger, highlight the test tone recording that has been retrieved 
from the reference DAT cartridge to the reproducer logger hard drive.  Click the Play icon.  The 
Playback window appears. 

(6)  Disable the Skip Silence feature in the Playback window. 
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(7)  Verify that the -10 dBm, 1004 Hz tone is being played by observing the reading from 
the receive side of the transmission test set. 

(8)  Setup an audio loop to repeatedly play this test tone.  Refer to TI 6670.11A for 
procedures on setting up an audio loop in NiceLog Voice Logger. 

(9)  Observe the VU meter on the cassette player/recorder.  Use the input level control 
knob to adjust the right channel (time code) indicator such that it is at 0 dB.  Use the Volume 
Slider located in the upper right hand corner of the NiceLog Voice Logger window to adjust the 
left channel (audio) indicator such that it is at 0 dB. 

(10)  Press the Pause button on the cassette deck to place it in the record mode.  Record 
the test tone and time code to the cassette tape for five minutes. 

(11)  Stop the cassette deck.  In the NiceLog Voice Logger window, stop the audio loop 
and playback of the test tone. 

(12)  Rewind the cassette tape and play it back.  Observe the VU meter on the cassette 
deck.  The left and right channel indicators should be at 0 dB ± 2 dB.  Observe the TCD and 
verify that the time is synchronized with the cassette recording. 

(13)  Stop the cassette deck playback, rewind the cassette tape, and place the cassette 
deck in the record/pause mode. 

(14)  Make no further adjustments to the cassette player/recorder and the NiceLog Voice 
Logger volume slider.  It is now properly aligned for making certified re-recordings of audio.  
The position of the cassette deck input level, balance, and output level controls should be noted 
for future reference. 

5-35.  Verify Cassette Player/Recorder Performance. 

(1)  At the reproducer workstation, login to NiceLog Voice Logger using the sysadm user 
ID, and connect to the reproducer logger. 

(2)  In the upper right hand corner of the NiceLog Voice Logger window, select the 
output channel that is physically connected to the cassette player/recorder.  Verify that the output 
channel is setup according to paragraph 5-13. 

(3)  Playback an audio recording from the reproducer logger hard drive.  Verify that the 
left and right channel indicators on the cassette deck VU meter are at 0 dB ± 2 dB.  Verify that 
the time displayed on the TCD is synchronized with the time displayed in the NiceLog Voice 
Logger playback window to within four seconds. 

(4)  Insert a blank recordable cassette tape into the cassette deck.  Rewind the cassette to 
the beginning of the tape.  Place the cassette deck in the record/pause mode.  Refer to TI 
6670.11A for information on the cassette deck operations and the pause/record mode. 
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(5)  Playback an audio recording from the reproducer logger.  Place the cassette deck in 
the record mode.  Record the audio and time code to the cassette for five minutes.  If necessary, 
use the loop feature of the NiceLog software.  Refer to TI 6670.11A for procedures on setting up 
an audio loop in NiceLog Voice Logger. 

(6)  Stop the cassette deck.  In the NiceLog Voice Logger window, stop the audio loop 
and playback of the audio. 

(7)  Rewind the cassette tape and play it back.  Observe the VU meter on the cassette 
deck.  The left and right channel indicators should be at 0 dB ± 2 dB.  Observe the TCD and 
verify that the time is synchronized with the cassette recording. 

(8)  Have a representative from AT evaluate the playback audio quality of the cassette re-
recording. 

5-36.  Inventory All Software and Configuration Backup Disks. 

Note:  It is extremely important that the software provided for each logger and workstation is 
specific to that logger or workstation.  For example, the reproducer Logger Installation Package 
will not work properly on a recorder logger.  The software disks must be properly labeled and 
can not be confused. 

a.  Each logger (recorder, IRR, and reproducer) at the facility must have a complete set of 
logger software labeled with the logger name or ID with which it corresponds (i.e. Logger 101, 
DRU_#_01, Reproducer 551, REP_#_01, etc.).  The complete set of required logger software is 
shown in paragraph 3-32.  Software that is NOT listed in paragraph 3-32, 3-33, or 3-34 must not 
be loaded or executed on DVRS loggers. 

Note:  The number of channels for each logger should be clearly indicated on the label of the 
NiceLog Logger Installation Package software disk. 

b.  Each workstation (recorder, reproducer, and remote) at the facility must have a complete 
set of workstation software labeled with the workstation with which it corresponds (i.e. Recorder 
Workstation, Reproducer Workstation, Remote Workstation, etc.).  The complete set of required 
workstation software is listed in paragraph 3-31.  Software that is NOT listed in paragraph 3-31 
or 3-34 must not be loaded or executed on DVRS workstations. 

c.  Each facility must have the Spare Disk Configuration Utility (SDCU) disk listed in 
paragraph 3-33.  This software disk is common for all loggers (recorder, IRR, and reproducer). 

d.  Each facility must have an updated configuration backup disk, made locally, for each 
workstation (recorder, reproducer, and remote) and logger (recorder, IRR, and reproducer).  
Refer to paragraphs 5-27 and 5-28 for procedures on creating or updating the workstation and 
logger configuration backup disks. 

e.  Facilities may also have optional software disks listed in paragraph 3-34. 
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5-37.  Complete/Update Logger Information Record Sheet.  Make a copy of the Logger 
Information Record Sheet, provided at the end of this chapter, using a copier.  Fill in the 
information that pertains to the site, and then make enough copies for each logger (recorder, IRR, 
and reproducer) at the facility.  Fill in the missing information on the sheet for each logger, and 
store each sheet with the maintenance documentation for the corresponding logger.  The 
information will be used for future maintenance.  A new worksheet must be completed anytime 
the logger configuration changes 

5-38.  Complete/Update Workstation Information Record Sheet.  Make a copy of the 
Workstation Information Record Sheet, provided at the end of this chapter, using a copier.  Fill 
in the information that pertains to the site, and then make enough copies for each workstation 
(recorder, reproducer, and remote) at the facility.  Fill in the missing information on the sheet for 
each workstation, and store each sheet with the maintenance documentation for the 
corresponding workstation.  The information will be used for future maintenance.  A new 
worksheet must be completed anytime the workstation configuration changes. 
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Logger Information Record Sheet 

Facility (Ex: ZSE ARTCC):  

 

Location: 

Installed Date: 

 

Commissioned Date: Record Sheet Updated Date: 

Logger Type (Recorder, IRR, or 
Reproducer): 

Logger ID / Logger Name: 

 

Logger IP Address: 

Serial Number (if applicable): 

 

Authentication Key: 

 

Number of Channels: 

 
Chassis Version (Dash-4, Dash-
5, Dash-6): 

SCSI Card: 

 

Network Interface Card (NIC): 

CPU Card (for Dash-4 and Dash-
5 Chassis): 

VGA Card (for Dash-4 and Dash-
5 Chassis): 

CPU/VGA Card (for Dash-6 
Chassis): 

Hard Drive: DAT Drive #1: 

 

DAT Drive #2: 

 

Input Channels 

Channel
Number 

Channel 
Name 

Activity Statistics
Alarm Enable Y/N 

Max. Activity 
Rate (%) 

Max. Rate 
Period (Hrs) 

Min. Activity 
Rate (%) 

Min. Rate 
Period (Hrs) 

01       

02       

03       

04       

05       

06       

07       

08       

09       

10       

11       

12       

13       

14       

15       
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Logger Information Record Sheet (Continued) 

Channel
Number 

Channel 
Name 

Activity Statistics
Alarm Enable Y/N 

Max. Activity 
Rate (%) 

Max. Rate 
Period (Hrs) 

Min. Activity 
Rate (%) 

Min. Rate 
Period (Hrs) 

16       

17       

18       

19       

20       

21       

22       

23       

24       

25       

26       

27       

28       

29       

30       

31       

32       

33       

34       

35       

36       

37       

38       

39       

40       

41       

42       

43       

44       

45       

46       

47       

48       
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Workstation Information Record Sheet 

Facility (Ex: ZSE ARTCC): 

 

Location: 

Installed Date: Commissioned Date: Record Sheet Updated Date: 

Workstation Type (Recorder, 
Reproducer, or Remote): 

Workstation IP Address: 

 

Network Interface Card (NIC): 

Scheduled Recording Enable (Y/N) 

Period 1:  From:    To: Period 2:  From:    To: 

Configured Loggers 

Logger Name 
(Ex: DRU_#_01, REP_#_01) 

Logger TCP/IP Address 
(Ex: 100.0.0.101) 

Configured Output Channels 
(Ex: 1, 2, 3, etc.) 

   

   

   

   

   

   

   

   

Configured Users 

Reproduce Only Monitor Only Others 
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Chapter 6.  Flight Inspection 
 
6-1.  General.  The Digital Voice Recording System (DVRS) equipment is not flight checked 
independently but must be considered to be an integral part of an air/ground communication 
system that is flight checked.  Refer to the latest edition of Order 8200.1A, United States 
Standard Flight Inspection Manual. 
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Chapter 7.  Miscellaneous 
 
7-1.  Purpose.  This chapter provides the electronics technician with additional information to 
assist in the operation and maintenance of the Digital Voice Recording System (DVRS) 
equipment.  If more detailed information is required than is presented here, refer to the latest 
edition of Order JO 6640.2, Maintenance of Audio and Speech Equipment. 

7-2.  Field Support Information.  Field support is available 24 hours a day, 7 days a week.  To 
obtain second level technical support for the maintenance and/or repair of DVRS equipment, 
contact the Oklahoma Communications Engineering Team (OKCET) for assistance. 

a.  OKCET telephone contact: 

(1)  Monday-Friday 0800-1700 Central Time: (405) 954-0066 

(2)  After hours and weekends: (866) 432-2622 

b.  OKCET email contact: AJW-1731-VoiceRecorders@faa.gov 

c.  Technical documentation website.  The OKCET maintains soft copies of all published 
documents on the FAA Intranet website:  http://nas.amc.faa.gov/technical_library/index.jsp .  
Government users may obtain FAA technical documentation services on the FAA Intranet site 
through the FAA Telecommunication Infrastructure (FTI) Remote Access Capability (FRAC) 
using the internet.  To obtain a FRAC account, contact: 

Gloria Richmond 
FTI Bus Ops Lead/FTI Mission Support Lead 
Email: gloria.richmond@faa.gov 
Desk:  202-493-5986 
Cell:  240-417-5639 

 
d.  Replacement DVRS software.  Software for the DVRS is provided on the FAA Intranet 

at the Voice Recorder System (VRS) website:  http://nas.amc.faa.gov/vrs/software.htm.  
Government users may obtain FAA technical documentation services on the FAA Intranet site 
through the FRAC using the internet.  To obtain a FRAC account, contact: 

Gloria Richmond 
FTI Bus Ops Lead/FTI Mission Support Lead 
Email: gloria.richmond@faa.gov 
Desk:  202-493-5986 
Cell:  240-417-5639 
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7-3.  DVRS Local Area Network (LAN) Transmission Control Protocol/Internet Protocol 
(TCP/IP) Addressing.  Table 7-1 outlines the mandatory logger identifications and TCP/IP 
addresses.  Devices that are not part of the DVRS system must NOT be connected to the DVRS 
LAN. 

 
Table 7-1.  Mandatory DVRS Logger Identifications and TCP/IP Addresses 

 
Equipment Type Equipment Description Logger Logger TCP/IP Address

  Number Name  
Recorder or IRR Equipment Recorder Workstation N/A N/A 100.000.000.100
Recorder or IRR Equipment Logger # 01 101 DRU_#_01 100.000.000.101
Recorder or IRR Equipment Logger # 02 102 DRU_#_02 100.000.000.102

Recorder Equipment Logger # 03 103 DRU_#_03 100.000.000.103
Recorder Equipment Logger # 04 104 DRU_#_04 100.000.000.104
Recorder Equipment Logger # 05 105 DRU_#_05 100.000.000.105
Recorder Equipment Logger # 06 106 DRU_#_06 100.000.000.106
Recorder Equipment Logger # 07 107 DRU_#_07 100.000.000.107
Recorder Equipment Logger # 08 108 DRU_#_08 100.000.000.108
Recorder Equipment Logger # 09 109 DRU_#_09 100.000.000.109

Reproducer Equipment Reproducer Workstation #01 N/A N/A 100.000.000.050
Reproducer Equipment Reproducer Logger #01 551 REP_#_01 100.000.000.051
Reproducer Equipment Reproducer Workstation #02 N/A N/A 100.000.000.052
Reproducer Equipment Reproducer Logger #02 553 REP_#_02 100.000.000.053

Remote Workstation Remote Workstation N/A N/A 100.000.000.060
 
7-4.  LAN Interconnection.  Table 7-2 outlines the recommended equipment to construct the 
LAN interconnection between the recorder and reproducer stations.  The diagrams for a typical 
LAN interconnection is shown in figure 7-1.  The LAN cable between the reproducer Ethernet 
hub and the recorder Ethernet hub cannot exceed 100 meters in length.  The cable should be a 
direct run with no other cable plant involved.  If more than 100 meters is required, an additional 
LAN hub may be used as a repeater as shown in figure 7-2. 

 
Table 7-2.  LAN Interconnect Parts 

 
Item Part Description 

1 Modular Plug 8 conductor, RJ-45, non-keyed plug 
4 LAN Cable 4 pair, Category 3 (10 MB/s LAN) Plenum rated 
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Figure 7-1.  Typical LAN Interconnection Diagram 
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Figure 7-2.  Long Distance LAN Interconnection Diagram 
 

a  
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7-5.  Audio Input of DVRS Equipment.  Figure 7-3 outlines the audio connections that go into 
the DVRS equipment.  Refer to figure 7-4 and figure 7-5 for the detailed diagrams of audio 
connections at the 48 Position Mini Bantum Patch Panel and at the 600 Ohm terminated 66-
block, respectively. 

 
Figure 7-3.  Audio Connection Diagram 
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Figure 7-4.  Audio Connection Diagram at the Patch Panel 
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Figure 7-5.  Audio Connection at the 600 Ohm Terminated 66-Block 
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7-6.  Cable Color Code for Audio Cables.  The cables used to provide connection from the 
audio sources for the DVRS equipment are typically 25-pair industry standard TELCO cables 
with connectors.  The color code and numbering used for these cables are presented in table 7-3. 

Table 7-3.  TELCO Paired Cable Information 
 

50 Pin TELCO 
Connector Pin Number 

Pair Number Base Color 
Code 

Trace Color 
Code 

1 1 (Tip) White Blue 
26 1 (Ring) Blue White 
2 2 (Tip) White Orange 
27 2 (Ring) Orange White 
3 3 (Tip) White Green 
28 3 (Ring) Green White 
4 4 (Tip) White Brown 
29 4 (Ring) Brown White 
5 5 (Tip) White Slate 
30 5 (Ring) Slate White 
6 6 (Tip) Red Blue 
31 6 (Ring) Blue Red 
7 7 (Tip) Red Orange 
32 7 (Ring) Orange Red 
8 8 (Tip) Red Green 
33 8 (Ring) Green Red 
9 9 (Tip) Red Brown 
34 9 (Ring) Brown Red 
10 10 (Tip) Red Slate 
35 10 (Ring) Slate Red 
11 11 (Tip) Black Blue 
36 11 (Ring) Blue Black 
12 12 (Tip) Black Orange 
37 12 (Ring) Orange Black 
13 13 (Tip) Black Green 
38 13 (Ring) Green Black 
14 14 (Tip) Black Brown 
39 14 (Ring) Brown Black 
15 15 (Tip) Black Slate 
40 15 (Ring) Slate Black 
16 16 (Tip) Yellow Blue 
41 16 (Ring) Blue Yellow 
17 17 (Tip) Yellow Orange 
42 17 (Ring) Orange Yellow 
18 18 (Tip) Yellow Green 
43 18 (Ring) Green Yellow 
19 19 (Tip) Yellow Brown 
44 19 (Ring) Brown Yellow 
20 20 (Tip) Yellow Slate 
45 20 (Ring) Slate Yellow 
21 21 (Tip) Violet Blue 
46 21 (Ring) Blue Violet 
22 22 (Tip) Violet Orange 
47 22 (Ring) Orange Violet 
23 23 (Tip) Violet Green 
48 23 (Ring) Green Violet 
24 24 (Tip) Violet Brown 
49 24 (Ring) Brown Violet 
25 25 (Tip) Violet Slate 
50 25 (Ring) Slate Violet 
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7-7.  Audio Output Interconnection.  Refer to table 7-4 for necessary parts to construct the 
audio bus.  There are two configurations for the audio bus interconnection between the recorder, 
reproducer, and remote workstations (if available).  The audio interconnection shown in figure 
7-6, which includes time interconnection, allows system specialists to directly re-record recent 
recordings from the recorder logger hard drive to a cassette tape at the reproducer workstation.  
Retrieval of recordings from the Digital Audio Tape (DAT) cartridge onto the reproducer logger 
hard drive is therefore not necessary.  This configuration is also used for Integrated Recorder 
Reproducer (IRR) equipment.  The audio bus can also be interconnected as shown in figure 7-7. 
 

Table 7-4.  Audio Bus Interconnect Parts 
 

Item Part Description 
1 Modular Plug RJ-11, 6 position, 4 conductor 
2 Telephone Y Adapter 2 RJ-11 jacks, 1 RJ-11 plug, 6 position, 4 conductor 
3 5 Outlet Modular Tap 5 RJ-11 jacks, 1 RJ-11 Plug, 6 position, 4 conductor 
4 Audio Cable 2 pair, Category 3 twisted pair Plenum rated 
5 Silver Satin Line Cord 4 wire silver satin base cord (bulk) 
6 Telephone Coupler 2 RJ-11 jacks, 6 position, 4 conductor 
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Figure 7-6.  Audio with Time Interconnection Diagram 
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Figure 7-7.  Audio Bus Interconnection Diagram 
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7-8.  dBrnC and dBm.  Completion of the maintenance tasks in this order requires knowledge 
of both dBm and dBrnC.  dBrnC is known as the decibel above referenced noise for C-message 
weighting (voice frequencies).  0 dBm is equal to 90 dBrnC.  Table 7-5 shows the relationship in 
more detail. 
 

Table 7-5.  dBm Versus dBrnC 
 

dBm dBRNC 
0 90 
-5 85 
-10 80 
-15 75 
-20 70 
-25 65 
-30 60 
-35 55 
-40 50 
-45 45 
-50 40 
-55 35 
-60 30 
-65 25 
-70 20 
-75 15 
-80 10 
-85 5 
-90 0 
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Appendix A.  Reserved 
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Appendix B.  Reference DAT Cartridge Creation 
 

B-1.  Purpose.  This appendix provides instructions for creating a reference Digital Audio Tape 
(DAT) cartridge.  The reference DAT cartridge is needed for reproducer performance checks and 
cassette deck calibration.  It is to be created on-site prior to commissioning.  Should one need to 
be created after commissioning, it is recommended to create a reference DAT at the time of the 
daily DAT cartridge change (i.e. after the previous cartridge is ejected and before the new 
cartridge is inserted). 

B-2.  Equipment and Materials Required.  This procedure is written with the following 
assumptions: 

a.  A recorder logger with at least one spare input channel is used for recording a test tone.  
Using a spare channel will record only the test tone and will not interrupt the recording service. 

Note: If a spare channel is not available, a recording service outage for one channel will 
need to be coordinated with air traffic (AT). 

b.  The recorder logger has the software parameters correctly configured and has the overall 
system gain for all channels properly established. 

c.  The facility is using the following equipment to generate and insert a test tone to the 
recorder logger.  Other means may be considered as long as the end result is attained. 

(1)  A transmission impairment measuring set (TIMS) HP-4935A, or transmission test set 
model 44 (TTS-44), or equivalent. 

(2)  A 48-position miniature bantam, FAA-provided Telex patch panel, or equivalent, to 
feed the Digital Voice Recording System (DVRS) 600 Ohm terminated 66-blocks. 

B-3.  Procedure. 

a.  At the recorder workstation, login to the NiceLog Voice Logger application using the 
sysadm user ID, and connect to the recorder logger that will be used to create the reference DAT 
cartridge. 

b.  Under the View pull-down menu, select Inputs.  Refer to figure B-1 for the Input Channels 
view. 
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Figure B-1.  Input Channels View 

 
 

c.  Highlight the target input channel (spare) that is used to record the test tone.  Select Stop 
recording input channel from the Record pull-down menu. 

d.  Under the Record pull-down menu, select Record input channel to restart recording on the 
target channel.  By doing this, the test tone recording on the target channel will be separated 
from the previous audio and will be easy to locate later in this procedure. 

e.  Configure the transmission source impedance for 600 Ohm terminated mode, and deliver 
a -10 dBm at 300 Hz tone.  Insert this test tone into the target channel through the Telex patch 
panel for a minimum of 30 seconds.  Verify that the target channel has the activity symbol 
displayed on the screen.  Repeat this step for -10dBm at 600 Hz, 1004 Hz, 2700 Hz, and -30 
dBm at 1004 Hz. 

f.  At the completion of introducing tones, select Stop recording input channel from the 
Record pull-down menu.  Disconnect the transmission test set from the input channel. 

g.  Select Recordings from the View pull-down menu.  In the Recordings – All view, shown 
in figure B-2, locate the test tone recording on the target channel by looking for the Start Time 
and Stop Time of the tone recording.  If necessary, playback the recording to ensure it contains 
the test tones. 

Figure B-2.  Recordings – All View 
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h.  Click the Decks icon on the toolbar.  The Decks window appears.  If the Deck operation is 
“Automatic Archiving,” perform the following sub-steps to disable the automatic archiving.  If 
the Deck operation is “Not Used” (i.e. automatic archiving is disabled), proceed to step i.  Click 
Close to close the Decks window. 

(1)  Select Setup automatic archiving from the Archive pull-down menu.  The Automatic 
Archiving Setup window appears, as shown in figure B-3.  Disable automatic archiving by 
unchecking the Deck 1 or Deck 2 box, and click OK. 

(2)  A warning message stating that automatic archiving is being disabled appears; click 
OK.  The DAT ejection notification appears; click OK.  Wait for the DAT cartridge to eject, and 
remove the DAT cartridge. 

i.  Select Manual archiving from the Archive pull-down menu.  When prompted to select 
Append or Overwrite, click on Overwrite. 

j.  At the prompt to insert a DAT cartridge for manual archiving, insert a brand new DAT 
cartridge for reference DAT creation, and click OK. 

k.  In the Decks window, verify that the operation has changed to “Manual Archiving.”  Wait 
for the DAT cartridge to load.  When the Status changes from “Loading” to “Ready,” click Deck 
1 (or Deck 2).  The DAT Contents window appears and should be empty.  Click the Start 
Archiving button. 

l.  The Archiving From Disk To DAT window appears.  Select the target channel that 
contains the test tone, as shown in figure B-3, and click OK. 

Figure B-3.  Archiving From Disk To DAT Window 

 

m.  The Manual Archiving From Disk To DAT window appears.  Enter the test tone 
recording times in the From and To fields, and then click Archive. 

n.  Close the DAT Contents window.  In the Decks window, when the Status changes from 
“Archiving” to “Ready,” the manual archiving is complete.  Click Deck 1 (or Deck 2) to view the 
DAT Contents.  Verify the test tone recording is listed in the DAT Contents window.  Click the 
Quit Manual button.  A message window will appear, stating the DAT is ejecting; click OK. 
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Note:  For Integrated Recorder Reproducer (IRR) equipment, the test tone recording is 
needed for calibrating the cassette deck.  Do not delete the test tone recording from the IRR 
hard drive yet.  It can be deleted later.  For recorder equipment, the test tone recording can be 
deleted from the recorder hard drive at this point. 

o.  In the Recordings – All view, highlight the test tone recording.  In the Playback pull-down 
menu, select Delete recording. 

p.  Select Setup automatic archiving from the Archive pull-down menu.  In the Automatic 
Archiving Setup window, enable the deck that was disabled in step h, and click OK. 

q.  The software prompts to insert a DAT for automatic archiving.  Insert the appropriate 
DAT cartridge for automatic archiving, and click OK.  Click the Decks icon on toolbar to open 
the Decks window and verify that the DAT is loaded and starts to archive.  Close the Decks 
window. 
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Appendix C.  Glossary 
 

This appendix provides the definition of terms, abbreviations, and acronyms that are used 
throughout this order or are associated with the recording service. 

 

A 

ac - alternating current. 

ADIF - Analog Digital Interface.  A CCA within the logger that provides analog to digital and 
digital to analog conversion and data compression. 

AFAAR - Airway Facilities Aircraft Accident/Incident Representative. 

AGC - Automatic Gain Control. 

ALI - Analog Line Interface.  A CCA within the logger that provides connections for analog audio 
channels to the ADIF. 

APA - Audio Processing Array.  A CCA within the logger that provides support for voice 
detection and other audio processing functions. 

Archiving - The process of copying recorded audio files to a DAT cartridge for long-term storage. 

ARTCC - Air Route Traffic Control Center. 

ARTS - Automated Radar Terminal System. 

AT - Air Traffic. 

ATC - Air Traffic Control. 

ATCSCC  - Air Traffic Control Systems Command Center. 

Audio file - The smallest unit of recorded data that can be archived, retrieved, or automatic 
deleted.  Each audio file has a corresponding 512 Kb physical disk file entity. 

 

B 

BIOS - Basic Input Output System.  A group of routines stored as firmware within a personal 
computer.  These routines allow the computer processor to be able to provide input and output to 
the computer peripherals during the boot process. 
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C 

Calls - Calls are segments of active audio that are separated by at least a certain length of silence.  
Each call contains at least a certain length of audio. 

CCA - Circuit Card Assembly. 

CD-ROM - Compact Disk - Read Only Memory. 

CERAP - Central Radar Approach. 

CMOS - Complementary Metal-Oxide Semiconductor.  An integrated circuit technology that 
produces integrated circuits which consume very small amounts of power in their operation 
compared to other technologies. 

COTS - Commercial Off The Shelf. 

Computer Workstation - The PC that is used to control loggers.  The reproducer station and the 
recorder station must each have a workstation. 

CPU - Central Processing Unit. 

Crosstalk - A measure of signal leakage between channels. 

 

D 

DAT - Digital Audio Tape. 

dB - Decibel (symbol). 

dBm - Decibel referenced to 1 mW (symbol). 

dBrnC - Decibels above reference noise with C-message weighting (symbol). 

dc - direct current. 

DDS - Digital Data Storage. 

DOD - Department of Defense. 

DOS - Disk Operating System. 

DRU - Digital Recording Unit.  A computer controlled recorder capable of recording up to 48 
separate voice channels.  The term logger and DRU are used interchangeably.  These terms reflect 
the actual recording equipment.  Within the DVRS there are several loggers.  Each logger may 
contain up to 48 channels which are used to record AT conversations.  The reproducer must have 
one logger, while the recorder workstation may be installed with multiple loggers or DRUs. 
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DVRS - Digital Voice Recording System. 

 

E 

ESD - Electrostatic discharge. 

Ethernet - A common bus oriented data communications suite of hardware. 

 

F 

Firmware - Software that is stored permanently in some sort of PROM technology storage 
medium.  This software is usually used for programs which control the operation and the 
operational behavior of equipment. 

FOIA - Freedom of Information Act 

FRAC - FTI Remote Access Capability. 

FSEP - Facilities Service and Equipment Profile.  A collection of computer databases maintained 
by the agency to track equipment and services in the NAS. 

FSS - Flight Service Station. 

FTI - FAA Telecommunication Infrastructure. 

 

G 

GMT - Greenwich Mean Time (obsolete); replaced by UTC. 

GPS - Global Positioning System.  A network of orbiting satellites used to provide highly 
accurate positioning information.  It is also used for the broadcast of time information. 

 

H 

HD - High Density. 
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I 

IRIG - Inter-Range Instrumentation Group (A US Government Agency).  IRIG-B is the IRIG time 
code format B.  IRIG-E is the IRIG time code format E. 

IRR - Integrated Recorder/Reproducer.  An alternate DVRS configuration that provides 
cassette reproduction capability at the recorder.  Sites fielded with a reproducer system 
(normally located in the Air Traffic Quality Assurance office) are not provided an IRR.  
The IRR integrates a dual cassette deck and TCD into the recorder equipment rack.  The 
IRR is typically fielded at smaller facilities.

ISA - Industry Standard Architecture. 

 

L 

LAF - Logger Auxiliary Function.  A CCA within the logger that provides analog audio outputs 
and time synchronization. 

LAF I/O - Logger Auxiliary Function Input/Output.  A CCA within the logger that provides 
additional time code input and output ports for LAF board. 

LAN - Local Area Network. 

LED - Light Emitting Diode. 

Logger - A computer-controlled recorder capable of recording up to 48 separate voice channels.  
The term logger and DRU are used interchangeably.  These terms reflect the actual recording 
equipment.  Within the DVRS there are several loggers.  Each logger may contain up to 48 
channels which are used to record AT conversations.  The reproducer must have one logger while 
the recorder workstation may be installed with multiple loggers or DRUs. 

LLWAS - Low Level Wind-Shear Alert System. 

LRU - Lowest Replaceable Unit.  The smallest portion(s) of the equipment that can be serviced 
in the field.  Anything smaller than the LRU (i.e. items within an LRU) will require the complete 
replacement of the LRU in question. 

 

M 

MCR - Multi-Channel Recorder. 

Microsoft® Windows™ - The graphical operating system used on the computer workstations of 
the DVRS equipment. 
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MOA - Memorandum of Agreement. 

Monitoring - Listening to audio as it is being received by an input channel from the recorder 
logger (or DRU). 

MS® - A registered trademark of Microsoft Corporation. 

MS-DOS® - The operating system used on DVRS loggers.  MS-DOS is a registered trademark of 
Microsoft Corporation. 

MVIP - Multi-Vendor Interface Protocol. 

 

N 

NAS - National Airspace System. 

NiceLog - A trademark of NICE Corporation. 

 

O 

OKCET - Oklahoma Communications Engineering Team. 

 

P 

PCTCP - Personal Computer Transmission Control Protocol. 

PROM - Programmable Read Only Memory.  A type of storage technology; the contents cannot 
be changed once they have been programmed. 

 

Q 

QEMM - Quarterdeck Expanded Memory Manager.  QEMM is a trademark of Quarterdeck 
Office Systems. 

R 

RAPCON - Radar Approach Control. 

Recording - 1.  The process of storing audio from an audio source on the hard drive of a recorder 
logger (or DRU).  2.  A unit of recorded data on a single input channel between the time the 
recording process is started and the time it is stopped. 
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Retrieval - The process of copying archived audio files from a DAT cartridge to the hard drive 
of the logger (or DRU) for the purpose of playback. 

 

S 

SCSI - Small Computer System Interface. 

SDCU - Spare Disk Configuration Utility. 

 

T 

TCA - Time Code Attenuator. 

TCD - Time Code Display. 

TCP/IP - Transmission Control Protocol/Internet Protocol. 

TELCO - Telephone Company. 

TIMS - Transmission Impairment Measuring Set. 

TPR - Technical Performance Report. 

TRACON - Terminal Radar Approach Control Facility. 

TTS - Transmission Test Set. 

 

U 

UHF - Ultra-High Frequency. 

UPS - Uninterruptible Power Supply. 

UTC - Universal Time Coordinated.  The time provided in world-wide time signal broadcasts used 
in aviation.  It has replaced Greenwich Mean Time as the accepted standard clock time in many 
countries. 

UTP - Unshielded Twisted Pair. 
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V 

VHF - Very High Frequency. 

VGA - Video Graphics Array. 

VRS - Voice Recorder Systems, formerly known as Multi-Channel Recorders (MCR).  Typically 
used to refer to analog multi channel voice recorders previously used throughout the FAA for voice 
recording of air-to-ground communications between pilots/air crews and Air Traffic Control. 

VSCS - Voice Switching and Control System. 

VU - volume unit. 

 

W 

Windows™ - The graphic operating system used on the DVRS workstation. 

Workstation - A desktop computer that is the user’s interface to the logger(s) via the DVRS LAN. 

WWV - The radio station which broadcasts time and frequency services, located in Fort Collins, 
CO. 
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